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1. Getting Started

Once you are accustomed to it, Mobile Resource Manager has an easy-to-use interface. Knowing a few simple
steps will have you working like a pro! This Help file is designed to help you with the standard version of Mobile
Resource Manager.

If you have any custom features and need assistance with them, please contact us for
support.(http://1e1.005.myftpupload.com/contact/)

1.1. Logging In

To log in to Mobile Resource Manager, you can either double click the Mobile Resource Manager desktop icon
located on your desktop or you can click on the Start button on Windows Operating System and open Mobile
Resource Manager through the program listing.

When you open Mobile Resource Manager, it will ask you for a User ID and password. These have been supplied
to you by MRM Support personnel or your own administrator. You may change your own password at any time by
clicking on “File” and then “Change Password”.

Mobile Resource Manager’s main form will look like the picture below:
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1.2. Layout

If you notice, Mobile Resource Manager contains two panels – Navigation and Information.

The Navigation Panel (better known as the Cabinet) is the vertical strip on the left side of the main form. The
Cabinet is grouped by folders; the first folder in the Cabinet is the Customer Equipment folder. Other folder names
include Customers, Dispatch, and Management Reports. There are two styles of cabinets that you can use,
Button and Tree View. The Button style, which is shown below, is the most commonly used. Both styles are
described below.

 7 / 204



 

 
Mobile Resource Manager

The Information Panel is the rectangular panel to the right of the Navigation Panel and just below the Toolbar. It
starts just under the Call button (the red phone icon). The panel’s appearance depends on the type of View you
select, such as a Data grid, a Dispatch Board, or Map. For example, if you select “Customers [All]” grid, the Info
Panel will look like this:

Style of Cabinets

There are two different styles you can set the Cabinet to be viewed as: Button or Tree View. The Button style is
shown below. It lists the topic names on buttons in the cabinet. In order to see topics in each folder, you must click
on the folder button in the cabinet.

Tree View can be described as a graphical outline of folders. By clicking on the plus sign (+) beside a folder, it will
expand and show its sub-folders. If there is a minus sign (-) beside the folder, the folder is already open and is
showing its sub-folders. To close that folder, simply click on the minus sign.
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To select a style for viewing the cabinets:

1. Click Tools
2. Choose either “Show Cabinet Button Bar” or “Show Cabinet Tree View”. The User Group you are a

member of and that group’s rights will determine which folders show up in your cabinet

To select a style for viewing the cabinets:

1.3. Views in Folders

View types are data grids, reports, dispatch boards, and maps that are launched from folders in the Cabinet. Each
view will have an icon in front of it to indicate what type it is.

This icon represents a Data Grid(http://www.jobcost.com/Data_Grids_2.html)

This icon represents a Data Grid with one or more parameters. A parameter (also known as a prompt) is a
question that is asked in order to retrieve more precise data for the view. Such prompts could be for you to:

Enter a Date Range
Enter the Customer Name
Enter the Call ID number
Enter the Technician’s Name

This icon represents a Report(http://www.jobcost.com/Reports_2.html)
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This icon represents a Dispatch Board(http://www.jobcost.com/Dispatch_Board_2.html)

This icon represents a Map(http://www.jobcost.com/Dispatch_Board_2.html)

1.3.1. Menu

File
Tools
Operational Link
Forms
Help

1.3.1.1. File

New Item(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/file/new-item/)

Print Setup(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/file/print-setup/)

Refresh Cabinet(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/file/refresh-cabinet/)

Refresh Cabinet Combo Box(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/file/refresh-cabinet-combo-box/)

Change Password(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/file/change-password/)

Logon as Different User(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/file/logon-as-a-different-user/)

Administration(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/file/560-2/)

Exit(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-folders/menu/file/exit/)

1.3.1.1.1. New Item

The New Item option in the File menu allows you to add a new item from the list of choices.

The list includes:
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Once you choose an item from the list, the form for that item will open. You then can enter the appropriate text.

Note: From the Toolbar, you can also use the New button to accomplish this; more information can be
found here.(http://www.jobcost.com/New_Item_2.html)

Useful Links:

Entering a New Contact
Entering a New ContactMgmt       – Under Construction!
Entering a New Customer
Entering a New Employee
Entering a New EquipType
Entering a New Location
Entering a New Pricing Type
Entering a New Service Call
Entering a New Technician

1.3.1.1.2. Print Setup

Print Setup allows you to choose your default printer.

Choose the default printer from the list and click OK. It also allows you to enter printer options, such as landscape
layout.
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If you need assistance with setting up your default printer, please contact MRM
support(http://www.jobcost.com/Print_Setup.html)
.

1.3.1.1.3. Refresh Cabinet

Refresh Cabinet puts all the grids, reports, and folders back in their rightful places. It also opens the folder that
you have set as your default folder to open upon log in. This is normally used when a new grid or new folder is
created. Before users can view the new information, you should click Refresh Cabinet.

1.3.1.1.4. Refresh Cabinet Combo Box

Refresh Cabinet Combo Box is used when an administrator creates a new Cabinet. Users won’t be able to see
the new cabinet until they click this refresh button. Once clicked, the options to view the cabinets will be updated.
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1.3.1.1.5. Change Password

When you open Mobile Resource Manager, it will ask you for a User ID and password.

These should have been supplied to you by MRM Support(http://www.jobcost.com/Change_Password.html)
or your own administrator.

To change your login password: 

1. Click File
2. Select “Change Password”.

3. Enter your old password and then type in your new password twice.
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4. Click OK when finished.

TIP: You will not receive a prompt stating you have changed your password; it is automatically in effect the next
time you log in. 

 

1.3.1.1.6. Log On as Different User

In some instances, you may need to Logon as a Different User. This comes in handy when users have different
rights to view items and need quick access.

To Logon as a Different User: 

1. Click File

2. Choose “Logon as a Different User”

3. Type in the “User ID” and “Password”

4. Click OK

5. You will now be logged in as the new user.

1.3.1.1.7. Administration

1.3.1.1.8. Exit

Clicking Exit will exit Mobile Resource Manager.
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1.3.1.2. Tools

Sending Text
Text Settings
Maps
New Service Call
Show Button Bar
Show Tree View
Hide Tree or Bar
Options

1.3.1.2.1. Sending Text

MRM has a built in messaging service that works along with your current Cellular Service Provider. The way it
works is MRM sends an email to the provider which sends a message to the number provided.

To send a text:
1. Click Text in the toolbar

The Navigation Panel (better known as the Cabinet) is the vertical strip on the left side of the main form. The
Cabinet is grouped by folders; the first folder in the Cabinet is the Customer Equipment folder. Other folder names
include Customers, Dispatch, and Management Reports. There are two styles of cabinets that you can use,
Button and Tree View. The Button style, which is shown below, is the most commonly used. Both styles are
described below.
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The Information Panel is the rectangular panel to the right of the Navigation Panel and just below the Toolbar. It
starts just under the Call button (the red phone icon). The panel’s appearance depends on the type of View you
select, such as a Data grid, a Dispatch Board, or Map. For example, if you select “Customers [All]” grid, the Info
Panel will look like this:

STYLE OF CABINETS

There are two different styles you can set the Cabinet to be viewed as: Button or Tree View. The Button style is
shown below. It lists the topic names on buttons in the cabinet. In order to see topics in each folder, you must click
on the folder button in the cabinet.

Tree View can be described as a graphical outline of folders. By clicking on the plus sign (+) beside a folder, it will
expand and show its sub-folders. If there is a minus sign (-) beside the folder, the folder is already open and is
showing its sub-folders. To close that folder, simply click on the minus sign.

To select a style for viewing the cabinets:

1. Click Tools
2. Choose either “Show Cabinet Button Bar” or “Show Cabinet Tree View”. The User Group you are a

member of and that group’s rights will determine which folders show up in your cabin

Once you select a Cabinet style, that style is automatically saved and will be used the next time the application is
opened from that workstation. See User Group Rights.(http://www.jobcost.com/Setup_Group_Rights.html)

1.3.1.2.2. Text Settings

MRM has a built in messaging service that works along with your current Cellular Service Provider. The way it
works is MRM sends an email to the provider which sends a message to the number provided.

To send a text:
1. Click Text in the toolbar
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2. The Send Text form appears

3. Click Add to add the employee you are sending it to

4. Check the check box beside the employee you are sending the message to. You can select multiple employees

5. Enter in text for the message

6. Click Send

HINT: You must have employees with a number set up that will receive text messages in order to send a page.
Read step 7 on the Setting up new Employees(http://www.jobcost.com/Entering_a_New_Employee.html)
 page for more details. 

Setting up the Text Service:
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You must have the Text Messaging Settings created before you will be able to send text. SEE Setting Up Text
Messaging Service Settings(http://www.jobcost.com/sendingpages3.htm)
 for more details.

1.3.1.2.3. Maps

1.3.1.2.4. New Service Call

New Service Calls are entered when a call comes in from a client or potential client. There are a few ways to enter
a New Service Call, all of which are outlined below. Please refer to the first method

[Method 1] To enter a New Service Call:

1. From the menu, click Tools

2. Click New Service Call

3. The New Service Call form will open.
Remember, this is your record of the call. Enter as much or as little information about the call as you wish.

1.3.1.2.5. Show Cabinet Button Bar

There are two ways to view the cabinet: Button Bar and Tree View.
The Show Cabinet Button Bar changes the cabinet into a Button Bar system. The Button Bar puts the folders on a
button in the cabinet.

To Show the Button Bar:

 

1. Click Tools

2. Click Show Cabinet Button Bar

3. The Cabinet will change the folders to buttons
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1.3.1.2.6. Show Cabinet Tree View

There are two ways to view the cabinet: Button Bar and Tree View.
The “Show Cabinet Tree View” option changes the cabinet into a Tree View system. This view gives the data in
the cabinet icons of folders beside each one.

To do this: 

1. Click Tools

2. Click Show Cabinet Button Bar

3. The Cabinet will change the folders to buttons

4. The + by the folders state that there is information in the folders.

5. Click the + to open the folder. 
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1.3.1.2.7. Hide Tree or Bar

Clicking Hide Cabinet Tree/Bar closes the left pane, the side that holds the cabinet, and expands the right side
that contains the actual data. Uncheck it to show the left pane.

To do this:

1. Click Tools

2. Click Hide Cabinet Tree/Bar

Tip: You can also click the ‘Hide’ button on the toolbar to achieve the same effect. 

Tip: An alternate way to hide the Cabinet Tree/Bar is to simply press F9.

See the page on
Options(http://1e1.005.myftpupload.com/mobile-resource-manager/getting-started/views-in-
folders/menu/tools/options/)
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 for more options on the Cabinet Tree/Bar.

1.3.1.2.8. Options

Options under Tools allows you to select which cabinet will open as default. You can also change which View
(Tree or Button Bar) your cabinet is viewed as or you can manipulate the Item forms. The option to change your
password and edit your Email Account (for messaging purposes) is also located here.

The general Options screen is shown below:

Modem Setup

Email Accounts 

The built in Texting and Paging service works along with your current Cell provider. MRM sends an email to the
provider, which in turn sends a message to the number provided. Before sending a message, you must enter your
email settings in Mobile Resource Manager. Click the EMail Account button on the options form to open the EMail
Connection Info form.
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To Setup Text Messaging Service Information:

1. Enter in the correct Email Connection Information.

2. Click If you have any questions setting up the Text Service Information, you can see how to set up those
settings on this(http://www.jobcost.com/Sending_Text.html)
page or speak with your IT personnel or contact our support team.(http://www.jobcost.com/Options.html)

1.3.1.3. Operational Link

We have included an operational link in the toolbar. When you first log in to Mobile Resource Manager, the link is
active and displays according to your default startup view. It normally appears between “Tools” and “Forms”. In
order to change it, you must click on an item, such as a grid. What you select from the cabinet, such as a grid,
determines what name is given to the operational link and its list of topics.

For example, if you click on the Dispatch Board, the operational link changes to “Board” and shows an entirely
different list.

You can then click on Board and a new menu list will appear:
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For example, if you click on the “Customers [All]” grid, the Operational Link switches to “Data Grid”.

The Data Grid’s first three topics (New, Open, and Delete) will pertain to the Customer table. They will read as
“New Customer”, “Open Customer”, and “Delete Customer”. If you click on Invoices [Date Range] grid, the Data
Grid’s first three topics will be New Invoice, Open Invoice, and Delete Invoice. The rest of the topics remain the
same no matter what grid you were last on.

The above list is self explanatory. However, if you have any questions, please contact our support
team.(http://www.jobcost.com/Operational_Link.html)

For more information on filtering grids, See our help page on Filtering
Grids(http://www.jobcost.com/filteringandsorting.htm)
.

There are 3 items on the above list that need more explaining: Export Grid, Show/Hide Columns and Grid Layout. 

Export Grid will open the Save Grid Data to file form. This allows you to save the file, along with exporting certain
fields. 
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Show/Hide Columns allows you to edit what is shown in the grid. If you want to show all fields except “Active”,
uncheck the box beside “Active” and click OK.

Grid Layout gives you the option to “Save Changes to Original View” or “Save as New View”.

Check the boxes that apply and click OK.

Clicking Edit View opens up the SQL view that was used to create the grid. 
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We strongly advise that only personnel with SQL programming knowledge manipulate the views. The slightest
change in the programming code could alter more than one item. For a brief explanation on how to edit
parameters of a grid, see this page(http://www.jobcost.com/Addin_Prompts.html)
.

1.3.1.4. Forms

1.3.1.5. Help

Clicking on Help gives you two options:

1. Clicking on Web Help will take you to the Mobile Resource Manager Web Help home
page(http://1e1.005.myftpupload.com/mobile-resource-manager/)
, which allows you to navigate through all of the topic-based web help pages via the left-hand navigation column
on each page. 

TIP: You can also reach Web Help by pressing the button on the toolbar.

 25 / 204



 

 
Mobile Resource Manager

2. Clicking on About… will display a screen displaying information about your version of MRM.

1.3.2. Toolbar

New Item
Sending Text
Map
Call
Hide
Documents
Help
Exit

1.3.2.1. New Item

The drop down list for New Item allows the user to add a new item from the list of choices, including:

1.3.2.2. Sending Text

MRM has a built in messaging service that works along with your current Cellular Service Provider. The way it
works is MRM sends an email to the provider which sends a message to the number provided.

To send a text:

1. Click Text in the toolbar

1.3.2.3. Map

Pressing the Map button in the toolbar will display your Headquarter’s location on a map if it has been entered in
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the Administration settings.

1.3.2.4. New Service Call

New Service Calls are entered when a call comes in from a client or potential client. There are five ways to enter a
New Service Call outlined below. Please refer to the first method for the simplest way.

[Method 1]

1. On the toolbar, click the Call button.

2. The New Service Call Form opens. Fill out all necessary information to finish creating the call.

3. Click Save and Close to finish.

[Method 2]

1. When you are viewing any kind of dispatch board, right click on the grid

 27 / 204



 

 
Mobile Resource Manager

2. A context menu appears. You can select New Service Call…  to create a new call

3. The New Service Call Form opens. Fill out all necessary information to finish creating the call

[Method 3]

1. Navigate to File > New Item

2. A context menu appears. You can select Service Call to create a new call

3. The New Service Call Form opens. Fill out all necessary information to finish creating the call

[Method 4]

1. From the menu, click Tools.

2. Click New Service Call.

3. The New Service Call form will open. Remember, this is your record of the call. Enter as much or as little
information about the call as you wish.

4. Click Save and Close to finish.

[Method 5]
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1. Press the F10 key on your keyboard

2. The New Service Call Form opens. Fill out all necessary information to finish creating the call

1.3.2.5. Hide

Clicking Hide closes the left pane of the interface. This is the side that holds the cabinet and expands the right
pane or the right side that contains the actual data. Click it again to view the left pane.

Before Hiding: 

After Hiding: 
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1.3.2.6. Documents

Clicking Documents opens a popup file browser that allows you to open a file.

1.3.2.7. Help

The Help button will open your default web browser and take you to the Welcome
page(http://www.jobcost.com/MRM_Help.html)
, the homepage of the Mobile Resource Manager Web Help:

1.3.2.8. Exit

Clicking this button will exit Mobile Resource Manager.

2. Maintain Data Forms

Employee(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/employee/)

Technician(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/technician/)

Customer(http://Customer)

Location(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/location/)
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Contact(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/contact/)

Equipment(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/equipment/)

Equipment Type(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/equipment-type/)

Location Equipment(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/equipment/)

Service Call(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/service-contract/)

Service Contract(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/service-
contract/)

Inventory Item(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/inventory-item/)

Invoice(http://1e1.005.myftpupload.com/mobile-resource-manager/maintain-data-forms/invoice/)

2.1. Employee

The Employee form allows you to customize and edit information about an employee. When you first pull up the
form, the tab that appears by default is Main Info. This tab shows general information about the employee.

The Contact tab is especially for contact information. you can add text messaging service information in the
bottom left dialog box if needed.
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The Notes tab can hold any miscellaneous remarks on file regarding the employee. 

 

The User Fields tab allows you to name and fill out your own fields for employees. 
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2.2. Technician

The Technician form allows you to view detailed information specific to a technician in your workforce. The Main
Info tab displays information about the technician’s work, certifications, and comments.
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The Labor Costs/Billing tab displays pay rates for this technician. You can use the Find and Clear buttons to
enter and delete billing items respectively.

2.3. Customer

The Customer form allows you to edit information about your customers. The Main Info tab is used to edit and
display the most general customer details.
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– This button allows you to copy the contents of the
main info tab to the clipboard.

– This button directs you to a web map of the
customer’s location.

– This button will prepare a blank email with the
customer’s email set as the recipient.

– This button launches a web browser to the website
that is filed (if applicable).

– This button lets you look up a customer via Customer
ID #

The Locations/Detail tab displays a list of all the customer’s locations in the upper portion, while at the same
time displaying a list of recorded service calls in the lower portion.
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The Files tab will show links to any files that are associated with the customer. 
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The Notes tab is for any written information you might choose to add that is relevant.
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2.4. Location

The Location form is accessible through the customer’s profile, due to the fact that locations are automatically
created when a new customer is entered. In order to see details of a location, you must first click on one of the
customer’s locations in the Location/Details tab of the customer’s profile.

Tip: For more information on changing location information, see this
page(http://www.jobcost.com/New_Loc_Existing_Customer.html)
.

The Main Info tab displays general information about the location. 

– This button allows you to copy the contents of the
main info tab to the clipboard.

– This button directs you to a web map of the
customer’s location.

– This button will prepare a blank email with the
customer’s email set as the recipient.

– This button launches a web browser to the website
that is filed(if any).

– This button lets you assign a customer to this
location. 
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The Main Info tab displays general information about the location.

The Details tab displays recent service calls relating to that location. If you make a service call and assign it to
this location, that service call would appear here.
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The Files tab is used for placing and accessing files related to this location.
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The Notes tab allows you to write any comments that pertain to the location.
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The User Fields tab allows you to name and fill out your own fields for additional location details.
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2.5. Contact

Contacts are useful for keeping track of acquaintances who are known to both you and your customers. To create
a new contact, go to File > New Item > Contact. A form like this will appear:
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The Contact form is similar in nature to the other data forms, except that it is specialized to hold data on a single
person. On the Main Info tab, you may enter information that describes this contact–specifically their name and
different methods for reaching them. It is important to note that the Main Info tab shows which company or
location the contact is associated with. A typical filled-out contact form may look like the example below: 
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The More tab allows you to enter additional information.This includes fields for where the contact resides as well
as their family details, if applicable.
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The Notes tab lets you write any comments desired.
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2.6. Equipment

The Equipment form gives you the ability to examine a single piece of equipment. For information on how to add
equipment to a service call, go here.(http://www.jobcost.com/Adding_Equipment.html)
On the Main Info tab, you can link the equipment to a customer as well as a location. Additionally, you can
specify the manufacturer, model #, warranty info, serial #, salesman, and a description with notes.
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An example of an active Equipment form is below; at first you’ll see the Main Info tab.
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The Service History tab shows any relevant service calls that involve this equipment.
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2.7. Equipment Type

The equipment type form allows you to specify a category of equipment that is distinguished from other
generalized types of equipment; this can prove useful when different types of equipment need to be compared or
examined. For a quick guide to setting up a new equipment type, see this
page.(http://www.jobcost.com/Location_Equipment.html)
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The Main Info tab displays the properties of the equipment type. The Equipment type field states what kind of
equipment is being described. The Manufacturer field stores the name of the company which makes the
equipment type. The Model # is the sequence that classifies this equipment’s type.

2.8. Service Call

The service call form is a record of your service to a client or potential client. For information on creating a new
service call, see this page.(http://www.jobcost.com/New_Service_Call_2.html)
The Main Info tab is where you place basic data relating to the call.
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The More tab displays a few useful things: First, it can display what equipment was serviced for this particular
call. To the right, there are fields for you to record error codes as well as resolution codes. The bottom portion of
the More tab displays the most recent service calls for your convenience.
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The Site Visits tab is meant to show a list of site visits related to this service call. Site visits will appear by default
from most recent to least recent. Whichever site visit you select will populate data fields at the bottom of the tab.
You can change that data directly from this form.

 53 / 204



 

 
Mobile Resource Manager

The Internal Note and Billing Note tabs are for your own personal use; feel free to comment on this service call
as much as you wish with these features.
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The Charges tab is meant for recording the price of all services rendered. See how to add charges
here.(http://www.jobcost.com/Adding_Charges_to_Invoice.html)
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2.9. Service Contract

The Service Contract form shows detailed information about a service contract you have with a client. To see how
to set up a service contract, click here.(http://www.jobcost.com/Service_Contracts_2.html)

The Main Info tab of this form displays basic contract details, the associated customer/location, scheduled
service dates, relevant equipment, and notes.

 57 / 204



 

 
Mobile Resource Manager

The Billing tab shows billing schedule, charges, and invoices.

The User Fields, Files, and Notes tabs all allow you to add additional details at your leisure.
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2.10. Inventory Item

Inventory Items can be added/imported/exported to invoices; see more information for moving Inventory Items
around on this page(http://www.jobcost.com/Exporting_Inventory_Items.html)
. To access them in MRM, you must first navigate to your invoices folder and find the grid that is labeled
‘Inventory Items’ or something similar. Here, you will find a list of such items. Here is what a typical inventory
item form looks like:

2.11. Invoice

The invoice form is comparable to a specialized form of a bill. See how to create an invoice
here.(http://www.jobcost.com/Generating_an_Invoice.html)
The Main Info tab of an invoice is shown below:

3. Entering Employees

New Employee
New Technician
Creating a Salesman
User Group Rights

3.1. New Employee

You can manually enter employees one at a time or you can import them into Mobile Resource Manager. MRM
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allows you to enter an individual employee in the case of new hires.

To Manually Enter a New Employee:

1. Click the drop down arrow beside New on the toolbar

2. The list below will appear

3. Click Employee.

4. The New Employee Form will appear.

5. Fill out all pertinent information. For more information about the employee form and what data it can hold, see
this page.(http://www.jobcost.com/Employee.html)

TIP:  You must enter a User ID or Mobile Resource Manager will prompt you that it cannot save. If this employee
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has Login Access, this will be the User ID that the employee will use to log in to MRM.

TIP:  Choosing the Employee Type of “Tech” does not make them a Technician that will show up on the Dispatch
Board. See the page on Entering a New Technician(http://www.jobcost.com/New_Technician.html)
for more details.

TIP: If you’re interested in changing what employee types are available, see the page on list
maintenance(http://www.jobcost.com/List_Maintenance.html)
.

6. Check the checkbox beside “Login Access” or “Is Salesman” if either apply

7. Click on the Contact tab to enter phone numbers, email, address information, etc

TIP: To set up text messaging information, see the page on setting up
texting(http://www.jobcost.com/sendingpages.htm)
.

8. Click on the Notes Tab to enter additional information
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9. Click on the User Fields tab to enter any other customized information.

10. Click Save and Close when finished

TIP: To view detailed information on the employee form, see this page(http://www.jobcost.com/Employee.html)
.
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To Import an Employee into MRM:

1. Click File.

2. Click Administration

3. Click Import Data…

4. The Import Data Form appears.

5. Under the “Select Import Type” drop-down list, select Employees
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6. Using the Browse button, select the employee’s file that you want to import.

7. Click Import

TIP: If you want to know more about running an import using MRM’s import/export feature in general, please
refer to this page(http://www.jobcost.com/Import_Data.html)
 for details.

3.2. New Technician

Every person entered in MRM, whether they are a technician or a dispatcher, is by default first categorized as an
employee.

There are two ways you can add an employee as a Technician:

1. Add a new employee as a technician OR

2. Make an existing employee a technician

To Add a New Employee as a Technician:

1. Click the down arrow by New in the toolbar

2. Click Technician

3. The Add Technician form appears

4. Choose the “Add New Employee as Technician” option

5. if the new employee will need Login Access, check the checkbox beside it.
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To Make an Existing Employee a Technician:

1. Click the down arrow by New in the toolbar

2. Click Technician

3. The Add Technician form appears

4. Choose the “Make Existing Employee(s) Technicians” option.

5. Click OK. You will be taken to the Tech form.
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6. Enter pertinent information then click Save and Close.

TIP: For more information on filling out the technician form, see this
page(http://www.jobcost.com/Technician.html)
.

3.3. Creating a Salesman

 

 

 

3.4. User Group Rights

User Groups and their rights are set up and altered by your Administrator or MRM Support. User Group Rights
are described as groups that are created with having rights to open, edit, create new, delete, and print specific
forms.

Mobile Resource Manager is set up with 2 default User Groups, Admin and Default. The Admin Group is set up to
allow every privilege for anyone in that group. The Default Group is set up with few advanced privileges. Users in
this group will not be able to access Administrative Settings. Once a group is created, you can add employees to
them. The employees will take on the same privileges the group has. You can of course create and edit your own
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groups!

If your business needs to create new user groups or If you are looking to alter rights to an existing group, please
see this page(http://www.jobcost.com/Setup_Group_Rights.html)
. If additional support is required, contact our support team.(http://www.jobcost.com/User_Group_Rights_2.html)

 

4. Entering Customers

Verify with Customer Database
Enter a New Customer
Automatic Location for Customer
The Customer-Location Relation
New Location/New Customer
New Location/Existing Customer
Move Location/New Customer
Move Location/Move Customer

4.1. Verify Customer with Database

You should enter a customer into MRM when that customer does not already exist in MRM’s database. Verifying
that the customer isn’t already stored in the customer database will reduce duplication errors that may cause
problems in the future.
If you know the customer does not already exist in MRM, continue to the “Entering a New
Customer(http://www.jobcost.com/Adding_a_New_Customer.html)
” subchapter.

To verify that the customer isn’t already stored in MRM, follow the steps below:
1. Click on the Customers folder in the cabinet located on the left side of your screen.

2. Click Customers grid to show all customers in Mobile Resource Manager or click Customer search by
Name grid to search by the customer’s name.
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3. Check the database to verify that they are not entered in MRM.

4. Continue to subchapter “Entering a New Customer(http://www.jobcost.com/Adding_a_New_Customer.html)
” to enter a New Customer in MRM.

4.2. Adding a New Customer

You can enter a new customer into MRM a few different ways, but the simplest way is described below:

To Add a New Customer:

1. Click the down arrow by New in the toolbar.

2. Click Customer for the New Customer form to appear.
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You could also:

a. Click on File and then click on New Item and choose Customer OR

b. Click click the Customer folder, then click on a customer grid such as “Customers” OR

c. Click on the New button that resembles a new document while viewing the Customers grid.

TIP: Since there are no required fields on the New Customer form, you may enter as much or as little information
as you want. We do suggest that you enter all pertinent information however.

This may include, but is not limited to:

-Customer’s name

-Customer’s billing address

-Customer’s phone number

-Name of the person you contact

 

Also note that MRM automatically assigns a unique Customer ID Number to each customer. You may wish to
change this number to better follow your business procedures. Contact MRM
Support(http://www.jobcost.com/Adding_a_New_Customer.html)
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for help doing this.

The Copy button copies the customer name, address,
city, state, zip, phone, fax, contact, title and email into
the Windows clipboard, for easy pasting into other
applications.  
The Email button works like a web page “Mail-to”
control, launching the default email program with the
address specified in the Email field already loaded in the
To field of a new email message.  
The Web button launches the default Internet browser,
and goes to the address specified in the Website field.
Also, the form itself is resizable. By default, it is always
displayed at the maximum size. It was designed for a
minimum screen resolution of 800 x 600 pixels, which
means at its smallest size it’s still larger than most MRM
screens.

4.3. Automatic Location for Customers

Once you save a new customer in MRM, they are automatically assigned a New Location. This is the same
information as you entered on the New Customer form, but is stored on the “New Location/Detail” tab on the
Customer form.
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MRM allows the customer to have multiple locations in case the customer owns multiple properties and performs
work at different locations other than their billing address. This feature comes in handy with clients such as
property owners.

Also note that MRM automatically assigns a unique Location ID # to each location that is entered. You can
change this number to better follow your business procedures if you wish.

4.3.1. The Customer-Location Relation

There are differences between Customers and Locations; the Customer is where you bill to and the Location is
where you perform work. Some customers have multiple locations associated to them.
A new customer is automatically assigned a New Location, once it is saved. The New Location gets the same
information, such as the address, as the customer. Locations are stored on the “New Location/Detail” tab on the
Customer form. You may edit this information at any time.

MRM allows the customer to have multiple locations in case the customer owns multiple properties or does work
at different locations other than their billing address. This feature comes in handy with clients such as property
owners.
Also note that MRM automatically assigns a unique Location ID Number to each location that is entered. You can
change this number to better follow your business procedures if you wish.

The following sub chapters explain the four types of relations between Customers and Locations.

TIP: To save time and money, Customers and Locations, along with other items, can be imported if you provide
MRM Support with a .csv formatted file. Please contact
them(http://www.jobcost.com/Customer_Location_Relation.html)
to find out what information can be imported and exported from MRM.

4.3.2. Entering a New Customer from the New Service Call Form

When you’re entering a New Service Call, you may need to enter in a New Customer. This is achievable from the
New Service Call form.

Follow the steps below:

1. From the “New Service Call” form, click the New/Edit button on the far right of the form.

2. Choose “New Location/New Customer” from the list.
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3. Enter important information pertaining to the customer.

4. Click the Save button.

5. Click Close on the “New Customer” form to return back to the New Service Call form.

6. Enter information pertaining to the call.

7. Click Save and Close

4.3.3. Adding a New Location to an Existing Customer

Entering a New Location to an already Existing Customer means that the location does not exist in the MRM
database but the customer does.

There are two main ways to add a New Location to an already Existing Customer:

1. From the New Service Call form OR

2. From the New drop down list on the toolbar

When you’re entering a New Service Call, you may need to enter in a New Location for an Existing Customer.

You can add a new location to an existing customer by following the steps below:

1. From the “New Service Call” form, click the New/Edit button on the far right of the form.

2. Choose “New Location/Existing Customer” from the list.

3. Enter important information pertaining to the customer.

4. Click the Save button.

5. Click Close on the “New Customer” form to return back to the New Service Call form.

6. Enter information pertaining to the call.

7. Click Save and Close

4.3.4. Move Existing Location to New Customer from the New Service Call
Form
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There may be times when you need to create a New Customer and affiliate it to a location already existing in
MRM. You can do this from the New Service Call form. The existing customer would still remain in the database,
but the location would no longer be affiliated with that customer.

For instance let’s say you had a customer named Company A and it is entered into MRM. Later on, Company A
was bought out by Company B. You now have a New Customer, Company B, with an already existing location.

Follow the steps below:

1. From the “New Service Call” form, click the New/Edit button on the far right of the form.

2. Choose “Move Location/New Customer” from the list.

3. Enter important information pertaining to the customer on the “New Owner for Location” form.

4. Click the OK button.

5. You will return back to the “New Service Call” form.

6. Enter information pertaining to the call.

7. Click Save and Close

4.3.5. Move an Existing Location to an Existing Customer from the New
Service Call Form

There may be times when you need to move an already existing location in MRM to an already existing customer
in MRM. You can do this from the New Service Call form. The existing location would thereafter not be affiliated
with the old customer.

An example would be if you had a customer Company A and a location at Company B but you wanted to move
Company B’s location to Company A.

Follow the steps below:

1. From the “New Service Call” form, click the New/Edit button on the far right of the form.

2. Choose “Move Location/Existing Customer” from the list.

3. Search the Customer database to chose with which customer this location should be affiliated.

4. Double click on the customer to open up the form.
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5. Enter information pertaining to the call.

6. Click Save and Close

5. Entering Service Calls

Entering a New Service Call
Copying a Service Call
Site Visits
Texts with Call Info

5.1. Entering A New Service Call

When a customer calls in for work to be done, the first thing you should do is document the call in a New Service
Call form. From the main screen, there are a few different ways to open the New Service Call form.

To Create a New Service Call:

1. You may choose to do one of the following:

a. Click the New Call button (the red phone)

5.2. Copying a Service Call
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5.3. Creating a Site Visit

You create a Site Visit when you do work for a customer. If you send a technician out to a site to do an estimate
or perform a service, you should document their work on a Site Visit. The Site Visit tab contains all information
pertaining to the actual Site Visit.

Buttons on the Site Visit Form

New – Creates a New Site Visit for that location

Multi – Creates multiple Site Visits for that location

Delete – Deletes the highlighted Site Visit (Be careful not to
hit the Delete with the X or you will delete the entire
Service Call.

Page – Sends a Page to a particular technician with the
Service Call information. See how to send pages
here.
(http://www.jobcost.com/Sending_Text__wit_Call_Inf
o.html)

Undo – Undoes the last thing done (i.e. entering Actual
Hours), except in the Internal Note field and the
Assigned Technician field.

Save – Saves the Site Visit.

To Create a Site Visit:

1. Open a Service Call or create a New Service Call.
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2. Once the Service Call is saved, click on the Site Visits tab.

3. The Site Visits tab is now open.

4. Click the New button next to the Multi button on the Site Visits tab to create a New Site Visit (not the New icon
next to Close. That creates a New Service Call). Read
below(http://www.jobcost.com/Creating_a_Site_Visit.html#Multi_Button)
to create Multiple Site Visits.

5. Notice that MRM automatically changes the Status to Scheduled, enters the Time Sched Date as today’s date
and the start time (defaults to 8 am, with 1 Estimated Hour.)

HINT: We can change the default time to whatever time you request, such as 7:00 am. The same goes for
Estimated Hours.
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6. Click Add located in the middle right of the form to Add a Technician.

7. Check the checkbox by the “Technician(s)” that will be doing work on this call. Work Performed contains
information pertaining to what the Technician did on site. This field is specific to the on Site Visit that it is entered
on, which is useful to giving detailed descriptions. Internal Note is a text field that is stamped on all Site Visits.
This means that whatever Site Visit you are on, you will be able to see whatever was typed in the Internal Note.

8. Once you’ve entered all pertinent information, click Save next to the “Internal Note” label on the form.

9. Click Save in the toolbar on the Service Call form.

10. Click Close

Multi button on the Site Visits form: The Multi button on the Site Visit allows you to enter Site Visits for a
specific location for multiple days at a time. This feature comes in handy when needing to create recurring visits
for the Service Call.
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To Enter Multiple Site Visits for the same Customer/Location:

1. On the Multiple Site Visits form, enter the starting and ending scheduled dates

2. It is optional to keep the checkbox beside “If there is already Site Visits scheduled on date do NOT create new
one” but is highly recommended.

3. You have the option to check “Save hours as ‘Charged'”

4. You can schedule multiple days up to multiple weeks at a time

5. Uncheck the days that you do not want Site Visits

6. Edit the starting time and how many hours they will be on site to the appropriate information.

7. Check the boxes beside the “Technicians” that will be on site.

8. Click Create.

9. MRM will calculate how many Site Visits were created. You can view and edit these Site Visits via the Dispatch
Board.

TIP: When scheduling multiple Site Visits, by default the technicians will be the same for each Site Visit. In order
to add or delete Technicians for Site Visits, you must open that particular Site Visit and click Add or Delete by the
Technicians field.

Changing the Site Visit Time increment:
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Mobile Resource Manager allows you to change the Standard Hours field to show different amount increments
that the customer will be charged. You can also change how many minutes you can minimally charge. For
example, say you had a Site Visit that only took 15 minutes. You can set this field to show half an hour minimum
charge or it can show the actual time or 15 minutes.

To Change the Standard Hours field:

1. Click File > Administration > Application Configuration > Application Options.

2. Click the drop down arrow by the Option Group field and select “Invoicing”.
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3. Change the “ChargedMinutesIncrement” field to suit your needs

4. Close out and you’re finished

5.4. Sending Text with Service Call Information
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There are two types of messages that can be sent through Mobile Resource Manager: regular messages that you
enter your own information and messages that have Service Call information.

Setting up the Text Messaging Service

You must have the Text Settings created before you will be able to send messages. See Setting up Text Settings
here.(http://www.jobcost.com/Text_Settings.html)

Regular Messages: You can send regular messages that contain information that you enter. See Sending
Regular Messages here.(http://www.jobcost.com/Sending_Text.html)

Service Call Messages: There are specific fields that can be entered in pages that contain Service Call
information. The information options that can be entered in the page are below:

 <CALLID>  <PROJNO>  <CUSTNAME>  <LOCID>  <LOCNAME>  <ADDRESS>

 <CITY>  <STATE>  <ZIP>  <PHONE>  <DEPARTMENT
>

 <CALLTYPE>

 <DESCRIPTION
>

 <DATESCHED>  <TIMESCHED>  <ESTHOURS>  <SCHEDCODE>

HINT: If it is imperative that you include an additional field in the messages that is not listed here, please contact
Mobile Resource Manager Support.(http://www.jobcost.com/Sending_Text__wit_Call_Info.html)

Follow the instructions below to change what is shown on the Service Call messages:

1. Click File

2. Click Administration

3. Click Application Configuration

4. Click Application Options

5. From the drop down list, choose “All”

6. Look for “Default Pager Text for Service Call”
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7. Click in the right-side box

8. Notice the format of the fields: [Call No: 1234] ABC Inc. (630)566-8400; 8:00 am
The [ ] are used to separate the fields, You can use any character to separate the fields, such as semicolons.

9. Once you click in this box, text will appear in the yellow box at the bottom of the form. Scroll down to see what
fields are allowed in pages.

10. Also notice the format of these fields (i.e. <DESCRIPTION>) The <> are required programming format. When
entering new fields in pages, you must include the <> on both sides of the field name for it to work.

To add a field to the page, such as Description (Service Call Work Requested):

1. Scroll through the “Default Pager Text for Service Call” field and click where you want to enter the new field,
such as after “TimeSched”.

2. Enter a semicolon and then hit the space bar a few times to separate “TimeSched” from “Description”

3. Type in exactly how it is shown in the yellow box: <DESCRIPTION>

4. Click Apply

5. Click Close

HINT: All pages will include the Description field in the page. If the entire page exceeds the given length (such as
150 characters) the page will be separated into 2 pages.

6. Data Grids

Data Grids
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Creating A Grid
Adding Prompts
Sorting a Grid
Filtering and Sorting
Filter/Sort Button
Using Wildcards
Filter by Cust Name
Filter by Phone #

6.1. Data Grids

 – Customer [All]  – Contacts  – Customer [Address]

 – Customer [Name]  – Employees [All]  – Customer Equipment [All]

 – Equipment [Model]  – Employees [Active]  – Invoices [Date Range]

 – Inventory Listing  – Locations [Name]  – Locations [Address]

 – Service Calls [Call ID]  – Service Calls [Unassigned]  – Service Calls to be invoiced

 – Service Calls [Locations]  – Service Calls [All Open]  – Service Calls [All]

 – Service Calls [Closed PS]  – Service Calls [Date Range]  – Service Contract [All]

 – Tech Site Visit [Date Range]  – Technicians [All]  – Technicians [Active]

 – Unassigned Technicians

 

6.2. Creating A Grid

Mobile Resource Manager allows users to freely create grids on the fly. In order to create grids, you must have
some SQL knowledge.
In order to create a new grid:
1. Right click on an empty space on the grey cabinet area and select New
2. Click Grid
3. The New Data Grid form appears. As mentioned above, you must possess some SQL knowledge in order to
make your own grid using this form

6.3. Adding Prompts

Some grids contain prompts that ask the user to answer a question or to enter information. Some examples are
below:

DateRange – Prompts you to enter a Date Range for possibly the Service Call or Site Visit, depending on how the
code is set up for the grid

Name – Prompts you to enter a name or select a name from the list

Address – Prompts you to enter the beginning of the address from either the Location, Customer, or Employee,
depending on how the code is set up for the grid

Call Status – Prompts you to enter a Status for the call

Department – Prompts you to specify a Department
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Tech Type – Prompts you to select a Tech type

ADVANCED CONFIGURATION: PARAMETERS ON GRIDS

If you happen to know SQL, you can create or edit the existing grids to pull information that you would like to see.
Each grid has their own code. Some grids have unique code and some use views that are pre-designed to pull
specific information. Be careful in editing the view’s code, other grids could possibly be using that same view.

As an example, we will create a grid that will prompt for the user to select a Technician from a drop down list or
click OK and every Technician will show in the grid.

The grid below will prompt the user to select a Technician from the drop down list or will allow you to click OK and
show information for every Technician.
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6.4. Sorting A Grid

Sorting is the act of arranging according to class, kind, or size. Any grid can be sorted or classified by the fields
that exist in the grid. For example, if you click on the Customers [All] grid, you can sort the grid by fields such as
“Customer ID”, “Customer Name”, “Address”, or “Phone” in ascending or descending order.
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SORTING A GRID

There are two ways you can sort grids. The first method is the easier method and is described in the following sub
chapters. The second method uses the Filter/Sort button. This takes a more advanced approach by filtering and
sorting a grid simultaneously. See how to use the filter/sort button
here.(http://www.jobcost.com/The_Filter_Sort_Button.html)
Once you click on a grid, you can sort the grid by any field that exists in the grid. For example, the Customers [All]
grid could contain the following fields: 

Customer ID # Customer Name Main Contact Phone Address

City/State Customer Type Active Industry Territory

This grid can be sorted by any of these fields.

If you want to sort the Customers grid to show city names in alphabetical (ascending) order, follow the
steps below:

1. Click on the Customers grid in the cabinet.

2. Find the “City” field and single click on the “City column heading” which looks like part of the toolbar. The grid is
now sorted alphabetically by city name.
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TIP: Sorting can help show fields that are missing critical information. It does this by listing empty fields first in the
sort order.

6.5. Filtering and Sorting

Once you click on a grid, you have the option to filter the grid by any field that exists in the grid. There are two
fields located above the grid – Filter By and Filter Text. The Filter By field contains all the fields that are located in
a selected grid. The Filter Text field allows you to type in the string you want to filter the grid by.

Below is an example using the Customers [All] grid:

The Customers [All] grid could contain the following fields:

Customer ID # Customer Name Main Contact Phone Address

City/State Customer Type Active Industry Territory
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Let’s say you want to locate the customer “Smith’s Inc” in the Customers [All] grid. Since Customer Name is a
field in that grid, you can filter the grid by it. You do not have to enter the customer’s full name, such as “Smith’s
Inc”; by entering any part of their name in the Filter Text field, such as “S” or “Sm” you can bring back any
customer that starts with that search criteria.

To filter by Customer Name:

1. Click on the Customers [All] grid in the cabinet.

2. Choose “Customer Name” from the drop down list in the Filter By field. (The Filter By field is centered
directly above the grid).

3. Type in the Filter Text field part of the customer’s name you’re searching on, such as “S” and click Enter.
You can also be more specific and type in “Smith” and it will pull back any customers whose name starts with
“Smith”, such as “Smithers” and “Smitherson”.

TIP: If you only have part of the search string, you can use a
Wildcard(%)(http://www.jobcost.com/Using_Wildcards.html)
in order to search for specific information.

6.5.1. Using the Filter/Sort Button

You can take an advanced approach to filtering and sorting grids by simultaneously filtering and sorting a grid
using the “Filter/Sort” button. This button, which is located in the grid’s toolbar, looks like a funnel.

Once you click on the button, you will notice that there are two tabs on the form – Filter and Sort.

On the Filter tab, you can set a filter on one or multiple fields. The Operator field contains mathematical operators
such as like, =, <>, >, >=, <, <=, between, and in.

1. You choose which field you want to filter.

2. Choose which operator you want to use (how you want to filter by).

3. Type in the value you are filtering by. The wildcard (%) is used in the text field in conjunction with the like
operator.

6.5.2. Using Wildcards (%)

Wildcards may be present in your search strings. A wildcard is a special character used in a search that can
match any character or string of characters. In Mobile Resource Manager, the wildcard is the percent sign (%).

The wildcard can be used at the beginning or end of search strings to match various patterns of letters. An
example when you might use the wildcard at the beginning of a search string would be if you were searching for a
main contact with the last name of Ackermann and you did not know its correct spelling. After selecting Main
Contact from the Filter By field, entering ‘%ack’ will pull back all Main Contacts with ‘ack’ in their name.
Remember, you could possibly get more than one result, such as Ackerman and Jackson.

You can also use the wildcard at the end of a search string. An example would be if you were searching for a
main contact and remembered their first name but not their last. After selecting Main Contact from the Filter By
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field, you could enter ‘Mike%’ in the Filter Text field to pull back every Main Contact that started with ‘Mike’. Note
this will not pull back ‘Michael’ because aliases and nicknames aren’t interchangeable.

The wildcards can also be placed at the beginning and at the end of a search string. Let’s imagine that your
receptionist took a message to call a client back at 630-566-8400.  When you call this number back, it’s the
wrong number. In order to search the MRM database, an option would be to type in ‘%566%’ in the Filter Text
field. This will pull back any numbers that have ‘566’ in them. Make sure the Filter By field shows Phone or it will
not pull back the correct information.

6.5.3. Filtering by Customer Name

The Customers [All] grid could contain the following fields:

Customer ID # Customer Name Main Contact Phone Address

City/State Customer Type Active Industry Territory

Let’s say you want to locate the customer “Smith’s Inc” in the Customers [All] grid. Since ‘Customer Name’ is a
field in that grid, you can filter the grid by it. You do not have to enter the customer’s full name, such as “Smith’s
Inc”; by entering any part of their name in the Filter Text field, such as “S” or “Sm” you can bring back any
customer that starts with that search criteria.

To filter by Customer Name:

1. Click on the Customers grid in the cabinet.

2. Choose “Customer Name” from the drop down list in the ‘Filter By’ field. (The ‘Filter By’ field is centered
directly above the grid).

3. Type in the Filter Text field part of the customer’s name you’re searching on, such as “S” and click
Enter. You can also be more specific and type in “Smith” and it will pull back any customers whose name starts
with “Smith”, such as “Smith” and “Smitherson”.

TIP: If you only have part of the search string, you can use a
Wildcard(%)(http://www.jobcost.com/Using_Wildcards.html)
 in order to search for specific information.  

6.5.4. Filtering by Phone Number

You can filter a grid by any field that exists in that grid. We will use the Customers grid for example. The
Customers grid could contain any of the following fields:

 – Customer ID #  – Customer Name  – Main Contact  – Phone  – Address

 – City/State  – Customer Type  – Active  – Industry  – Territory

Let’s say a customer calls in and leaves a message with your receptionist. The message is vague and only lists
the caller’s name and phone number. The message does not contain any other pertinent information, such as
what company he’s with. You can still find the customer in the database by filtering by Phone number since it is a
field listed in the Customers grid.

To filter by Company Phone Number:
1. Click the down arrow from the Filter By field and choose “Phone”
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2. Type the customer’s phone number into the Filter Text field and click Enter.
*TIP: If you only have part of the search string, you can use a
Wildcard(%)(http://www.jobcost.com/Using_Wildcards.html)
 in order to search for specific information.

7. Reports

Generating a Report
Emailing Reports
Report Templates
Add Logos to Invoices
Formatting Date/Time

7.1. Reports Overview

Mobile Resource Manager uses Quick Reports® as the report designer. If you use Crystal Reports®, you could
create and run reports within Crystal but you would have to use the ODBC data source to access the Mobile
Resource Manager data.

A Report shows information pertaining to the name of the report. A few reports include “Invoice Printout”, “Tech
Timesheet”, and “Work Order Printout”. Some reports are accessible through the Print button located on the top
of their respectable forms. Other reports can be accessed through sub-menus or through the Tools button on their
form.

The  icon represents a Report.

Even though the Report icon doesn’t show a parameter (the red question mark), they still can include
parameters. Parameters are usually revealed in the name of the report, such as Tech Timesheet by Date Range,
and will appear once you click on the report.

STANDARD REPORTS Mobile Resource Manager package comes with a group of standard reports:

Configuration Items
Invoice Printout
Invoice Report
Import Specifications
Proposal Printout
Service Contracts
Service History Locations
Site Visit Printout
Tech Timesheet
Work Order Printout (Original)
Work Order Printout (Site Visit)

Report templates are accessed through different methods. If you cannot generate a report that you know exists in
Mobile Resource Manager, please contact MRM Support.(http://www.jobcost.com/Reports_2.html)

If you would like changes to an existing report or would like to have a report created for you, MRM Support can
assist you. If you are requesting a custom report, please provide MRM Support with a detailed description and a
mock up of your request. It would also be helpful to include a list of the field names and the forms that they’re
located on when submitting such a request. This list will help the programmers locate the correct information
quickly and will cut down on billable time.
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However, if your company has personnel that has adequate training with Report Writing and SQL, please feel free
to create your own custom reports. We offer Report Writer training classes for our clients that are periodically
posted on our NEWS(http://www.jobcost.com/News.html)
page; contact your salesman(http://www.jobcost.com/Sales.html)
for more information. If you wish, you can also always contact our support
team.(http://www.jobcost.com/Reports_2.html)

7.2. Generating a Report

Some reports can only be accessed thru opening forms; Invoices have to be generated. As previously mentioned,
some reports are included in the base package.

These reports include:

Configuration Items
Invoice Printout
Invoice Report
Service Contracts
Service History Locations
Tech Timesheet
Work Order Printout

If you want to print a Service Call (also known as a Work Order):

1. Open the Service Call

2. Click the Print button

3. MRM will generate a Service Call report so that you can print out.

TIP: If you attempt to generate a report and receive “ERROR: Could not find Report Template”, it means that the
Report Template hasn’t been installed. Please contact our support team to install the template. See the section
on ERROR: Could not find Report Template.

7.3. Emailing A Report

The report screen allows you to email reports using the  EMail button.

After you click this button, Mobile Resource Manager will prompt you to enter the name of the report to be saved
as an attachment.
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Thereafter, MRM will open a new outgoing email in your default email application and attach the report to it. 
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7.4. Report Templates

Report Templates are used as an outline for the reports. We generate the reports using a built-in report writer.

7.5. Adding Company Logo to Invoices

MRM allows you to add your own logos to your invoices; to do so, open the report template in the Report Writer.

To add your company logo to invoices:

1. Click the Add New Image button in the left side toolbar

2. The cursor will change to a +

3. Single click where you want to add the logo

4. The Image form will appear so you can choose the file you want to import

5. You also have the option to “Stretch Picture”, “Autosize the report element to fit the picture”, and “Center
Picture”.

Stretch Picture Allows you to stretch and resize the image to the size
of the report element.

Autosize Allows you to resize the report element where you can
make the report element the size of the image.

Center Picture Centers the image in the report element. You
manipulate the border in order to get it correctly sized.

TIP: The report element is the border that surrounds the image.

6. Check any boxes that apply.

7. Once finished, click Save and Close under “File” when finished

If you have any problems, please contact support(http://www.jobcost.com/Add_Logo_to_Invoice.html)
 for help

7.6. Formatting Date/Time
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 Symbol Description

 yy Two digit year

 yyyy Four digit year

 mm Two digit month, or two digit minutes if following a
colon (as in ‘hh:mm’)

 mmm[m…] Character short form for months—as many characters
as there are “m”s

 dd Two digit day of month

 ddd[d…] Character short form for day of the week—as many
characters as there are “d”s

 hh Two digit hours

 nn Two digit minutes

 ss.ssssss Seconds and fractions of a second, up to six decimal
places.
Note: Not all platforms support timestamps to a
precision of six places.

 aa am if needed (12 hour clock)

 pp pm if needed (12 hour clock)

 f Use French days and months (deprecated)

Each symbol is substituted with the appropriate data for the date that is being formatted.

For symbols that represent character data (such as mmm), you can control the case of the output as follows:

Type the symbol in all upper case to have the format appear in all upper case. For example, MMM produces JAN.

Type the symbol in all lower case to have the format appear in all lower case. For example, mmm produces jan.

Type the symbol in mixed case to have Adaptive Server Anywhere choose the appropriate case for the language
that is being used. For example, in English, typing Mmm produces May, while in French it produces Mai.

For symbols that represent numeric data, you can control zero-padding with the case of the symbols:

Type the symbol in same-case (such as MM or mm) to allow zero padding. For example, yyyy/mm/dd could
produce 2013/01/01.

Type the symbol in mixed case (such as Mm) to suppress zero padding. For example, yyyy/Mm/Dd could produce
2013/1/1.

8. Dispatch Board

Dispatch Board
Board Types
Manipulating the Board
Changing Tech Status
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Board Options
Board Data Options
Editing Text
Service Call Map
Color Schemes

8.1. Dispatch Board Overview

The Dispatch Board resembles a calendar that lists site visits by technician/resource. The Dispatch Board will
resemble this:

The Dispatch Board will have the technicians/resources listed on the left-hand side of the board. The days are
listed across the top. Service Calls/Jobs will be listed in the boxes next to their assigned technician.

The top of the dispatch grid board has the following toolbar:

 Date – The first day that is listed on the Dispatch
Board

 Left and Right arrows – Use them to scroll to the
previous or following day

 Refresh – The green arrows will refresh the boards
information

 Service Call Map – Shows calls and site visits on a
map

 Printer – Prints what is on the screen

 Board Options – Customize the Dispatch Board’s
appearance

 Daily Board – Shows Visits on a daily basis
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 Multi-day Board – Shows Visits on a Multi Day basis

 Summary Board – Shows Summary of Visits, such
as hours

 Hide Call List – Hides the Call list located at the
bottom of the Dispatch Board

 Excl Competed – Excludes Site Visits that have a
Completed Status
(only shown when on the Daily Dispatch Board)

8.2. Board Types

There are three different layout views for the Dispatch Board:

8.3. Manipulating the Dispatch Board

You can right click on the Dispatch Board to bring up this menu:

Print Print Board
Print Site Visits for Technician
Print All Site Visits on Board for Date

Show Map Show Visits for (Technician’s Name)
Show All Visits on the Map

Refresh Board Refreshes any changes you’ve made and puts them
into effect

New Service Call Opens the Quick Entry New Service Call form

Change Status for Technician Changes status for the selected Technician

Multi-Tech Status Change Changes status for multiple Technicians

Cancel Cancels and closes the menu

8.4. Changing Technician Status

You can document a technician’s status, such as when they are on vacation, to show a holiday, or Paid Time Off.
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You can change one Technician’s status or multiple technicians’ status at once.

To Change Technician Status:

1. Open the Dispatch Board by clicking on it from the Cabinet in the Dispatch folder

2. Right click next to the technician’s name on the date that you want to change the status

3. Select “Change Status”

4. From the status drop down list, select the new status, such as “JuryDuty”

5. Change hours by clicking in the “Hours” field

6. You may enter Comments if you wish. You can view comments by double clicking on the Dispatch Board on
the Status.

Multi-Tech Status Change

You can change multiple technician’s status, such as when there is a holiday.

1. Open the Dispatch Board by clicking on it from the Cabinet in the Dispatch folder

2. Right click on the date that you want to change the status

3. Select “Multi-Tech Status Change”

4. Select the starting and ending dates
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5. Select the “Status Type”

6. Change the days and hours by checking/unchecking the boxes and changing the Hours

7. Check the boxes beside the technicians you want to change the status for or you can click the All button to
check all technicians. Alternately you can click the None button to deselect all the technicians.

8. Click OK. The number of Site Visits created will appear in the bottom left corner of this form.

After you have changed the status for a specific day, it will block the entire day in gray and will have what Status
Type you used, such as Holiday.

To edit the Tech Status List:

1. Click File > Administration > Application Configuration > List Maintenance
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2. Click the drop down arrow and select Schedule Status

3. You can add or delete from the Tech Status list and then click Close

If you are having problems changing the Tech’s Status:

1. Make sure the Special Right is set up in Advanced Config – Special Rights Types as “DB_ChangeEmpStatus”
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2. If it’s set up, click on the “User Groups” to add it to a particular group, then click Edit

3. Log out and log back in and you should now be able to change Tech Status

8.5. Board Options

Board Options gives you the opportunity to customize the Dispatch Boards to fit your preference.

You have the option to:

1. Select Board Type of Daily, Multi Day, or Summary

2. Select Start Date on the Board

3. Select Date on Open. Options are Today, Tomorrow, or This Monday

Tech Filters include:

– Department – Tech Type – Territory – Status – Rating(s)

– Check “Show Inactive Techs” if you want to show techs that are inactive

Tech Sort includes:

– Sort By – Then By – Then By

All of which include the option to sort by:
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– Name (which can show as Last Name, First Name or First Name Last Name)

– Department – Tech Type – Territory – Truck Number – Hire Date

– Sort Visits By: Scheduled Time or Scheduled Code

Daily, Multiday, Summary Options

The right side of the Board Options pertain individually to each Board.
(These options are the same for All Dispatch Boards Types!)

Data Width Changes the width of the boxes that contain Site Visits

Name Width Changes the width of the column that contains
Technician’s Name

Auto-Fit Columns Correctly proportions the columns

Gray Sunday/Saturday Check these to gray Saturday and Sunday

Exclude Competed Site Visits on Daily Board Site Visit Colors for Confirmed and Competed can be
manipulated. Click on the text to edit the background
and font colors.

These options are different between the Dispatch Boards Types:

Daily

Tech Info Width – Changes the width of the column next to the
technician’s name

Status Width – Changes the width of the technician’s status column

Max Hours – The number of maximum working hours in the day

Number Days – N/A

Custom Sat Width – N/A

Custom Sun Width – N/A

 

Multiday 

Tech Info Width – N/A

Status Width – N/A

Max Hours – Same number set in the Daily column

Number Days – Number of days that are shown on the Dispatch
Board

Custom Sat Width – Changes the width of the column (check the box to
change width)

Custom Sun Width – Changes the width of the column (check the box to
change width)
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Summary 

Data Width – Changes the width of the Totals column

Name Width – Same number set in the daily column

Tech Info Width – Same number set in the daily column

Status Width – N/A

Max Hours – N/A

Number Days – N/A

Custom Sat Width – Changes the width of the column (check the box to
change width)

Custom Sun Width – Changes the width of the column (check to box to
change width)

 

TIP: You must click the Save Options button located in the bottom left corner in order for the changes to stay
permanent. 

TIP: Checking the “Auto-Fit Columns” and entering numbers in the specific data width fields will show the boxes
as being somewhat equal. In order the manipulate the widths of the boxes so that they aren’t proportionate,
uncheck “Auto-Fit Columns”.

8.6. Board Data Options

Board Data Options allows you to manipulate what is shown on the Dispatch Board.

By clicking inside the white box next to the “Tech Name”, “Tech Info”, and “Tech Caption” fields, and then
clicking the “Insert” button, you can choose what fields to include on the Dispatch Board in these respective
fields.

 Your options are:
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By first clicking inside the white box next to the Site Visit Board Text or the Site Visit Caption Text Data fields and
then clicking the Insert button, you can choose what fields to include on the Dispatch Board in these respective
fields.

 Your options are:

By first clicking inside the white box next to the Summary Data field and then clicking the Insert button, you can
choose what fields to include on the Dispatch Board in these respective fields.

 Your options are:

TIP: If there is a field that must be shown on the Dispatch Board and it isn’t listed in these insert lists, please
contact Mobile Resource Manager Support for other alternatives.

Tech Info

Tech Info will show directly underneath or directly to the right of the technician’s name. In the image below, Tech
Info is their Mobile Phone and is located directly underneath the technician’s name.

Tech Caption

The Tech Caption is the black bar located at the bottom of the Dispatch Board.
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You can select fields from the Insert list that will show up in the Tech Caption bar when you hover your cursor
over the Technician’s name.

Site Visit Board Text

This is text that is viewed on the Dispatch Board by selecting from the Insert List.

Site Visit Caption Text

This text is viewed in the Caption bar when you hover over a Site Visit on the Dispatch Board.

Summary Data

On the Daily Dispatch Board, Summary Data summaries the site visit or tech’s information. In the first image,
<NUMVISITS>/<CHGHOURS> are included on the Summary Board.

To Add/Edit Board Data Options:

1. Click in the white text box next to the field you want to change.

2. To remove a field, highlight over it and click Delete

3. To add a field, move the cursor in the text box where you want to add the field

4. Click the Insert box located directly to the right of that field

5. Click the field you want to insert.

HINT: To make things look uniform, you can add spaces and punctuation to separate the fields.

8.7. Editing Text

In order to edit text, you must open up the form that you want to change text from. We will use the Customers [All]
grid for this example. The Customers [All] grid could contain the following fields:
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 -Salesman  -CustomerName  -Address1  -Address2

 -City  -State  -Zip  -Phone

 -MainContact  -CustID  -CODOnly  -CH

 -POReq  -LastContact  -NextContact  -Entered

 -CityStateZip  -Fax  -Title  -Email

 -Website  -CustType  -TaxExempt  -SalesTaxCode

 -Active  -Industry  -Source  -Territory

 -GuarResponse  -Terms  -Priority  -User Fields

TIP: Once you click on a grid, you can filter by any field that exists in that grid.

8.8. Service Call Map

Clicking on the Map icon above the Dispatch Board will open the Map Calls form. On this form, based on what
you enter, you are able to show site visits on a map.

The Map Center is defaulted to you Company’s headquarters. To set up the HQ, See Setting
HQ.(http://www.jobcost.com/Maps_4.html)

You have the option to:

1. Show Unscheduled Service Calls

2. Show Unscheduled Planned Service Calls (Contract Calls) and change dates for a number of days

3. Show Unassigned Site Visits in a particular Date Range

4. Set Call Filters based on Department, Call Type, and Territory
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5. Show Assigned Site Visits/Tech Homes

6. Manipulate the Date Ranges

7. Include site visits that have a status of Scheduled, On Site, or Completed

 

8.9. Color Scheme

The Dispatch Board is color-oriented. It will show Site Visits in different colors and also outlines them to help with
visual cues.

HIGHLIGHTED SITE VISITS
Normally, Site Visits with a status of “Scheduled” will be highlighted in blue, as shown below.

Other Site Visit Colors:

Blue Site Visits with status of
“Scheduled”

 Dark Grey Site Visits with status of “Tentative”

*Navy Site Visits with status of
“Confirmed”

 Burgundy Site Visits with status of
“Acknowledged”

Green Site Visits with status of “Tech On
Site”

Dark Grey w/Strikeout Site Visits with status of
“Cancelled”

Dark Grey Site Visits with status of
“Rescheduled”

 *Black Site Visits with status of
“Completed”

 Purple Site Visits with status of “Follow-
Up”

Light Grey Site Visits with status of Non-Project
Sites

* = These field colors are modifiable from Dispatch Board Options

OUTLINED SITE VISITS

As mentioned before, Site Visits are also outlined.

Yellow – Last modified Site Visit (shown below)
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Red – Indicates a warning, such as a time overlap

9. Maps

Maps

Built-in Maps

Internet Maps

9.1. Maps

The Map icon in the toolbar will take you to your Headquarter’s location provided it has been entered in the
Administration settings.

To set your HQ Address for the map, see Tools > Maps.(http://www.jobcost.com/Maps_4.html)

To assist with dispatching technicians and resources, Mobile Resource Manager can show locations of Site Visits
along with a technician’s home address. See Service Call Map(http://www.jobcost.com/Service_Call_Map.html)

9.2. Built-In Maps

Q. How do I move a location on the map to a different street in case it’s in the wrong place on the map?

A. On the location or Service Call forms, click the Tools button and select “Show/Edit Location on Map”. The map
will open with just that location in the center. If the site is not geocoded, it will open at the Headquarter location.
Drag the location bitmap to the correct location, then click the save button on the map dialog toolbar.

Q. How do I measure distances on the maps?

A. Hold down the shift key and then drag the mouse while holding down the left mouse button, the distance you
have dragged the mouse will show on the map.

9.3. Internet Mapping

Mobile Resource Manager offers a way to access Internet Maps, such as Google, Mapquest, and MSN Maps.
This feature allows you to open up an Internet browser and will automatically populate the Location’s Address in
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the address field. When the web browser opens, it will pinpoint the Location’s address in the center. From there,
you can print or map directions to and from the office or other site visits.

To view which mapping website you have access to:

1. Click File

2. Click Administration

3. Click Application Configuration

4. Click List Maintenance

5. Click the down arrow and choose “Internet Maps”

To change which Internet Map you access:

1. Click File

2. Click Administration

3. Click Application Configuration

4. Click Application Options

5. Click the down arrow and select “Mapping”

6. Choose which Internet Website you would like to access
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To Access the Web Browser via the Location form:

TIP:You must have the street, city, state, zip in the correct format in order for the internet maps to pull the
information – otherwise the web mapping service will not function as it should.

1. Open up a Location
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2. Click the down arrow on the “Tools” button

3. Click Open Internet Map

4. The web browser that you have chosen will now open with the Location’s Address mapped on it

To Access the Web Browser via the Service Call form:

1. Open up a Service Call
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2. Click the down arrow on the “Tools” button
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3. Click Open Internet Map

4. The web browser that you have chosen will now open with the Location’s Address mapped on it

To Access the Web Browser via the Employee form:

1. Open up an Employee’s form

2. Click the down arrow on the “Tools” button
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3. Click Open Internet Map

4. The web browser that you have chosen will now open with the Employee’s Home Address mapped on it

10. Invoices

Invoices Overview
Generating an Invoice
Adding Charges
Adding Labor
Exporting & Importing
Export Inventory Items

10.1. Invoices Overview

MRM allows you to generate invoices from the Service Calls. This is done through the “Charges” tab on the
Service Call. When you generate an invoice, you must include line items, such as parts.

TIP: Before creating an invoice, make sure that you have Inventory Items (i.e. parts) in MRM to add to the invoice.

10.2. Generating an Invoice

Once you have all the Parts listed in MRM, you can generate the invoice.

To generate an Invoice for a Service Call that is closed:

1. Open the completed Service Call
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2. Click on the “Charges” tab
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3. Click the Add button to enter line items on the invoice
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4. Click Find to select a Part Number
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5. Select the Part from the list and click OK
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6. Enter pertinent information and click OK
TIP: Most or all of the pertinent information should already be entered because you should have entered it when
you added Parts to the Inventory Listing.

7. Repeat steps 3 – 7 until all information you want on the invoice is listed

8. Click Create on the bottom of the Service Call to create (generate) the invoice. You may be prompted to close
the Service Call before creating the invoice.

9a. Click Open to open and edit the invoice (SEE the below paragraph) OR

9b. Click Print to preview the invoice before printing.

 118 / 204



 

 
Mobile Resource Manager

10. Once the invoice is open in preview mode, you can print it by clicking Print

MRM VC PO & IN import-sup(http://1e1.005.myftpupload.com/wp-content/uploads/2016/08/MRM-VC-PO-IN-
import-sup.doc)

Opening the invoice will allow you to edit certain parts of the invoice, such as the Invoice Number. If you are
generating an invoice from a closed Service Call, MRM automatically generates a number from that Service Call
and includes a prefix. If the Service Call number is 1234, the Invoice Number will be S1234 for Service Call. You
can remove this prefix at any time.

To remove the prefix from the invoice:

1. Click File

2. Click Administration

3. Click Application Options

4. Select “Invoicing” from the Option Group drop down list
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5. Find “Invoice Prefix”

6. Remove or change the prefix

7. Click Apply

PARTS and PHASES on INVOICES

When you select a Part from the list of Inventory Items, the Phase and Taxable Status that was set on the Part will
automatically default on the invoices. If you change the Phase on that item on the invoice, it will not change the
phase in the database.

Regarding Taxable Status: When you select a Part, the Phase and Taxable Status will be set to the defaults for
that part. If you change the Phase from the default, the taxable checkbox will change to unchecked (if it isn’t, if
“NonTax” is anywhere in the phase name. The taxable checkbox will change to checked if the phase name ends
in ” Tax” (space before) or if ” Tax ” (space before and after) is anywhere in the phase name.
When adding parts to the Inventory Listing, you can make sure the Taxable checkbox is or isn’t automatically
checked on invoices.

To do this:

1. Click on Inventory List grid under the Invoices folder

2. Click on the part you want to change

3. Check or uncheck the ‘automatically check Taxable checkbox’
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TIP: If you receive any error messages when exporting, you may find the solution in the FAQ’s under
Invoices/Accounting(http://www.jobcost.com/Import_Export.html)
or Company Logos(http://www.jobcost.com/Add_Logo_to_Invoice.html)
.

10.3. Adding Charges to an Invoice

Modifying the service call associated with the invoice is your first step to adding charges to an invoice.

1. Pull up the service call that the invoice will be made from:
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2. After doing this, navigate to the Charges tab:
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3. Here, you can use the Add, Labor, Travel, and Discount buttons to add different types of charges to your
invoice. Below are examples of each option:
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4. Upon completion, these charges appear on this tab’s list and be added to the total amount of charges on the
invoice.

10.4. Adding Labor to an Invoice

This page goes a little more into detail about adding labor charges to an invoice. When you have the service call
screen in front of you and switch to the Charges tab, it should look like the image below. Next, hit the Labor
button.

10.5. Exporting & Importing

Customers and Invoices are exported out of Mobile Resource Manager and imported into an accounting software.
Inventory Items and Parts are exported out of accounting software and imported into MRM.

Exporting an invoice into accounting software requires a two-step process: First, you export invoices from Mobile
Resource Manager and secondly you import those invoices into accounting software.

To export Customers and Invoices from Mobile Resource Manager into the accounting software:

1. Make sure all invoices are ready for transfer

2. Click File > Administration > Export Data or Accounting Link (depending on what version of MRM you
have)

3. If you receive the following error, you do not have the export accounting link set up. Please contact your
salesman(http://www.jobcost.com/Sales.html)
or alternatively contact support.(http://www.jobcost.com/Exporting_and_Importing.html)

4. The Export Data dialog box will prompt you to export Customers and Invoices. You may check the box by both
or which ever one you want to export. Click Export. You should receive no errors.
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5. When you export, the exporting link saves the Customers and Invoices in a file where it can be pulled into the
accounting software upon Import.

6. Now you need to open your accounting software and run the import.

To import Customers and Invoices into Peachtree from MRM:

1. Open up Peachtree®

2. Click File > Select Import/Export

3a. Click on “MRM Customers” to import customers then click the Import button OR

3b. Click on “MRM Invoices” or “MRM Sales Journal” to import invoices then click the Import button

4. On the next form, click OK

5. You might receive WARNING message prompts which is normal. Please hit OK and disregard them. However,
if you receive ERROR message prompts, please write down what the Line Item says at the bottom of the first
paragraph. This means that something on the invoice did not match records found in Peachtree®, in which these
invoices did not get transferred over and need to be looked at by our support
team(http://www.jobcost.com/Exporting_and_Importing.html)

6. If you did not receive any error message, all invoices should have transferred. Please double check in
Peachtree® that they did. They will more than likely be located at the bottom of the list. If you do not find an
invoice in Peachtree®, make sure you are looking at the correct dates. The date on the invoice, not the
transferred date, is how you could locate the invoice.

TIP: The Peachtree® link exports Customers but not Locations into Peachtree®. Invoices exported from MRM
into Peachtree® will include the location name/address as the ship-to. Since Peachtree® only allows up to 7
locations per customer, some clients use the Customer and Location ID fields to decipher which location it is
using.

To export Inventory and Parts from Peachtree® into MRM

1. Open up Peachtree®

2. Click on “Import/Export” from the File menu

3. Choose Inventory Parts from the list

4. Click OK

5. Open up MRM

6. Click File > Admin > Import Data
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7. From the “Select Import Type” select Peachtree® Items

8. The file that it is importing should already appear in the “Select File to Import” field

9. If you are allowing updates, check the box beside “Allow Updates”

10. You may enter a number in the “Abort after X errors” field in case there are a huge number, it will stop the
import process

11. If there are any errors, another tab called “View Errors” will appear on the form. You can click on it to see
what problems occurred. Please contact your salesman(http://www.jobcost.com/Sales.html)
 or our support team(http://www.jobcost.com/Exporting_and_Importing.html)
 for additional assistance

HINT: Because of how QuickBooks® is designed, we are able to automatically run the Inventory and Parts export
into MRM simultaneously with the import of Customers and Invoices into QuickBooks®.

Warning & error messages when importing/exporting:

You may receive error messages when importing into accounting packages, such as Peachtree®. Please note
that the warning messages can be misconstrued as the invoice didn’t transfer. This is incorrect. Please disregard
the warning messages, as they do not have any meaning.

Error messages, on the other hand, are signs that something is incorrect on the invoice and the invoice was not
transferred. There are a number of things that can cause errors to appear. If you look at the error message, you
will be able to see under “Line #” exactly what caused it.

Here are some examples:

1. Cust ID or Loc ID: The Customer/Location ID number on the invoice was not found in Peachtree®. This can be
caused by not importing customers.

2. Item ID: The line item on the invoice may be different than what is found in Peachtree®. This can be caused by
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adding inventory items/parts into Mobile Resource Manager and not into Peachtree®. We urge users to not add
inventory items and parts in Mobile Resource Manager and not the accounting software. Since we do have an
export/import for Inventory Items from accounting software into Mobile Resource Manager, we urge users to add
Inventory Items into the accounting software and then run the export/import.

3. Truncated: A line needs to be truncated – to be made smaller. This means that a field in Dispatch is shorter
than what is trying to fit in it. If this happens, you can rerun the export after shortening what is on it.

10.6. Exporting Inventory Items

To export Inventory Items from Peachtree®
1. Open up Peachtree®
2. Click File – Select Import/Export
3. Click on “Inventory” on the left side
4. Click on “MRM Inventory Items List” and then click the Import button
5. On the next form, click the OK button
6. Now you need to open Mobile Resource Manager and run the import.

11. Service Contracts

Service Contracts Overview
Scheduling Maintenance
Adding Equipment
Generating Invoices
Renew Service

11.1. Create a Service Contract

Mobile Resource Manager allows you to create Service Contracts for your clients. It also has a built in tool that
allows you to Renew Service Contracts. Before you can generate an invoice from a Service Contract, you must
first create the Service Contract.

11.2. Scheduling Planned Maintenance

When you create a Service Contract, you can create Planned Maintenance Service Calls from the contract. This
comes in handy when you need to schedule planned maintenance that falls under the contract every so often.

To set up Planned Maintenance Service Calls:

1. On the Service Contract, click on the New button underneath Scheduled Service
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2. The Scheduled Maintenace form appears

3. You may enter any information you wish. All these fields are located on the regular Service Call form.
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4. Choose the radio button beside “Schedule One Call” to schedule only one Planned Maintenance Service Call
or choose the radio button beside “Schedule Multiple Calls” to schedule multiple Planned Maintenance Service
Calls. These calls can be scheduled every month, every two months, etc. as long as the dates fall under the dates
of the Service Contract.

5. Click OK.

6. You now have Service Calls for that particular location. The difference between a regular call and a Planned
Maintenance Service Call is the Call Type. Planned Maintenance Calls have a Call Type of “4. Planned
Maintenance”.

7. In order to schedule a Site Visit, assign a technician, or add any other information to these type of calls, you
must open the Call by clicking Open button.

11.3. Adding Equipment

If you have equipment at a particular location that is covered under a contract, you can add it to the contract.

11.4. Generating an Invoice

Once you have created and linked a Service Contract to a location, you can now generate the invoice to send to
the customer.

To generate an invoice from the Service Contract:
1. Click Service Contracts folder in the cabinet
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2. Click the Contract Billing tool
3. The “Recurring Invoices” form appears

4. Click the down arrow beside “Bill Period Begins” in order to select the date that the Service Contract begins
5. Click the down arrow beside “Date to use for Invoices” in order to select the date that you want to show on the
invoice
6. Click OK. Depending on how many Service Contracts have the date that you entered in the “Bill Period
Begins” date depends on how many Service Contracts will be generated. The “Created 0 of new invoices” will
show how many Service Contracts that were created. For example, it could say “Created 3 new invoices”.
7. Click Cancel once it has created the invoices from the Service Contracts to exit out of that form.

To view the newly created invoice from the Service Contract:
1. Click Invoices folder
2. Click Invoices [Date Range]
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3. Enter the date that shows on the invoice as it was created.
4. A list of all invoices created on that date will show in the grid

5. Double click the specific invoice to open it

To print the newly created invoice from the Service Contract:
1. Click the Print Icon button in the toolbar
2. A preview of the invoice will appear. You can close the preview to return to the previous screen if changes need
to be made
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3. Click Print
4. Select the appropriate printer settings and click OK

11.5. Renewing Service Contracts

You can also renew an existing contract instead of creating a whole new contract. You can renew a contract with
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our Renew Contract feature from the Tools button OR you can do it manually. The only stipulation when using the
Renew Contract feature is that the contract must be one year in length.

To renew a contract using the Renew Contract Feature:
1. Open up the Service Contract
2. Click Tools – Renew Contract
3. The Renew Contract form appears
4. This form lists the current information, along with giving you options to edit certain fields.
5. The Contract ID will always remain. You may change the Contract Number, which appears on the Main Info
page of the Service Contract.
6. The Start and End Dates automatically push over to the next year.
7. You may enter the Contract Total, which also appears on the Main Info page of the Service Contract.
8. The Bill Amount can be changed. This is the amount that you bill the client for.
9. Last Bill Date is shown for your reference.
10. The Next Bill Date can be altered to whatever date you want to assign the invoice to go out.
11. Click OK when finished.

 

12. Optional Forms & Features

Custom Item Pricing
Document Linking
Contact Management

12.1. Custom Item Pricing
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12.2. Document Linking

Document Linking allows you to link certain documents directly to Customers, Locations, or Service Calls. The
documents should be stored in a location where everyone has access to them, such as on the server that
Dispatch is located on. Linking documents can come in handy when you often scan documents or need to keep
track of documents associated to a specific Customer.

There are 2 ways to link documents, you can use the Link Documents task or you can link documents directly
from the Customer or Location forms.

Link Documents Task in the Dispatch folder:
1. Click on the Dispatch folder

 or 
2. Scroll down to Link Documents and click on it.

3. The Link Documents Task form will appear.
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4. In the “Link To” list, you should have the option to link to a Customer, Location, Service Call, or Employee.
Choose what you’d like to associate the document to.

5. Enter in the ID number in the Item ID field and hit Enter. Look under the “Documents will be linked to” This will
show exactly what the document is being linked to. 

6. Click the Add button to find the document you want to attach. Remember, all the documents should be in a
neutral location where everyone can access them.
7. Find the document and click OK
8. Click OK on the Linked Documents form. A prompt will appear that says “Linked 1 document.”
9. Click OK. The document will disappear but it is still there. Click Close.

To verify that the document is linked:
1. Open the Customer form that you linked the document to
2. Click on the “Locations/Detail” tab and then click on the “Linked Docs” tab.
3. You will see the linked document. To open it, double click on it.

12.3. Contact Management

The Contact Management module is an alternate way to look at customer data, with an emphasis on treating
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customers as sales prospects. The Contact Management module feature involves several new fields in the
Customers table, a new form, and includes a new report template.

The Contact Management form has some additional features:

Copy button copies the customer name, address, city,
state, zip, phone, fax, contact, title and email into the
Windows clipboard, for easy pasting into other
applications.

Email button works like a web page “Mail-to” control,
launching the default email program with the address
specified in the Email field already loaded in the To
field of a new email message.

Web button launches the default Internet browser, and
goes to the address specified in the Website field.

Also, the form itself is resizable. By default, it is always displayed at the maximum size. It was designed for a
minimum screen resolution of 800 x 600 pixels, so at its smallest size, it’s still larger than most Mobile Resource
Manager screens.

13. Administrative Settings

View Users Logged On
Update Map Coordinates
Export Data
Import Data
Database Utilities
Application Configuration
List Maintenance
Application Options
Cabinets/Folders
Cabinets/Folders
Default Start Folder
Cabinets
Folders
Forms
Data Grids
Reports
Report Templates
Special Rights
Tasks
Users
Users
Setup Group Rights
Employees

13.1. View Users Logged In

Another tool that can be useful is the ability to view who’s logged in to Mobile Resource Manager at any given
moment.
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13.2. Update Map Coordinates

You need to Update Map Coordinates when you create new employees, customers, and locations in MRM. This
will Geocode all the addresses so that they are visible points on the Maps. Doing so will allow you to schedule
Technician’s to certain Site Visits depending on their location.

13.3. Export Data

In order to run exports, you must have purchased a link into your accounting software. To do so, please contact
your salesman.(http://www.jobcost.com/Sales.html)

The expdata.exe application is used to export data from Mobile Resource Manager to text files. The expdata.ini
configuration file is used to setup exporting.

To run the export:

1. Click File

2. Click Administration

3. Click Export

4. Select the export you are wanting to run.

5. Follow any prompts that appear.

NOTE: If an export is not required for an installation, place an “x” at the beginning of the parameter name and
that particular export will be disabled.

Settings for expdata.ini are as follows:

[Settings]

The following parameter sets the text file that is used
for exporting Customers.

CustExportFile=g:dispatchexportarcust.txt

The following parameter sets the text file that is used
for exporting Service Calls

SCExportFile=g:dispatchexportjcjobs.txt

The following parameter sets the text file that is used
for exporting Service Contracts

PmtExportFile=g:dispatchexportcontract.txt

The following parameter sets the text file that is used
for exporting Closed Planned Service Calls

ClosedExportFile=g:dispatchexportcontliab.txt

The following parameter sets the text file that is used
for exporting Billable Calls

BillableCallsFile=g:dispatchexportardetl.txt

The following parameter sets the text file that is used
for exporting Invoices

InvoiceFile=g:dispatchexportartran.txt

The following parameter sets the ODBC datasource
name that will be used by the Export program to
connect to the database.

ODBC DSN=dispatchdirect
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The following parameter lets the export program know
whether Dispatch Direct uses User Defined Service
Call Numbers.

UserDefCallNo=N

This parameter determines what GL Account is used
during Invoice exports.

InvoiceAccount=4000

 

Please feel free to contact our support team(http://www.jobcost.com/Export_Data.html)
if you have any questions.

13.4. Import Data

Mobile Resource Manager allows you to import files, such as Customers, Locations, and Invoices. You can also
export files from accounting software such as Inventory and Parts. In the steps below, we will import customers
from a .csv formatted document, such as an Excel Spreadsheet. Before you run the import, you must define the
import.

To reach Application Configuration:

1. Click File

2. Click Administration

3. Click Application Configuration

To Define the Import:

1. Click the Advanced button.
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2. Enter in the password that is provided by Mobile Resource Manager
Support.(http://www.jobcost.com/Import_Data.html)

3. Click on the + by Advanced Configuration.
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4. Click Imports and select the file you are importing, such as ‘Customer’, then click Edit.

5. The Import Specification Dialog box will appear.
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When importing from a csv formatted document, the column data in the spreadsheet must match the data that is
supposed to go into the MRM Field Names. For example, if you have “Customer Name” column in the
spreadsheet, it must be in the second column of the spreadsheet because it is the second item in the Import. (Use
the above picture for visual help).

1. The “Import Name” will be the name of the file you are importing, such as Customer

2. In the “Table Importing to” field, enter in the name of the MRM table that the text file will be imported into

3. In the “Default Import File” field, enter in the default name/path of the text file (if any). If this is not entered, the
user will need to select a file from a  browse dialog box.

4. You can add/edit/delete fields from the specification using the related buttons.

5. Use the up/down arrow buttons to edit the order that the fields appear in so that they match the import text file.
This is extremely important that the order here matches the order in the spreadsheet. If it doesn’t, the data will be
imported in the wrong fields.

6. Check the “Allow Record Updates” checkbox if you want to update existing data in MRM. At least one field will
need to be marked as a “Match” field. For a field like Customers, make sure that the Cust_ID field in the import
file matches the Acctg_Code in the Import Specifications. MRM looks at this field to verify that this customer
already exists in MRM.

7. Check the “Import File Has Header Row” checkbox if the first row in the text file includes field names. This will
make sure that the import process excludes this row when importing.

8. Click OK.

To edit an existing Import Specification:
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1. Double click the name in the list, such as Customer, or highlight it and click Edit.

2. The “Field Definition” dialog box will appear.

3. The value of “MRM Field Name” should be set to the name of the field in the MRM table you are importing to,
such as Customer or Customer Name. If the specific field in text file is not being imported, you should still insert a
column with a heading in case you will be using the field in an “After Insert” or “After Update” query.
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4. Set “Field Type” to the type of field. Choices are:

Boolean: Values of 1 or a string beginning ‘Y’ or ‘T’ will be considered True or anything else (including blank)
will be considered False.

Date

Float

Integer

Phone: MRM stores phone numbers as numbers only. For
Fields set as “Phone” type, any dashes, parenthesis,
etc… in the Text file will be stripped out on import.

SSN: Similar to phone numbers, MRM stores numbers only.
Dashes in import text file will be stripped out.

String

ZipCode: As with Phone/SSN, non-numbers will be stripped out.

5. “Lookup Value” can be used to translate the value from the text file to a related value in MRM. For example,
MRM uses the value Cust_ISN as a unique numeric value. However, a value in the text file may be a customer id
from another system. The import can use the Cust_ISN value from the customer table where the MRM
icscustomers.acct_code value equals the value from the import file.

6. Check the “Do NOT import” checkbox if the related field in the import file will not be imported to the named
MRM table. For example, if your import file for Customers contain Location information, you do not want to include
Location information in the Customer table as Locations have their own table. Also, if there are location headings
in the import file, make sure that they do not copy headings for customer fields. For example, Customers could
have Address1 and Address2 to import address lines. Locations can contain the same fields. Rename location
headings to LAddress1 and LAddress2 to avoid errors.

7. Check the “Auto ISN” check box if the MRM field is an Identity (auto-incrementing) field. If the import file does
not contain this field, insert a column specifically for this field. If this field is left blank, the value will be generated
automatically. You could also number it yourself; 1, 2, 3, etc.

8. Check “Match field” if the field value will be used to determine if a related record already exists in MRM. For
example, when importing customers from an accounting system, the import would check if the value in the import
file had a match in the CustID field of the MRM customer table.
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When a Customer is created, MRM automatically creates a related Location. More details on this can be found
here(http://www.jobcost.com/Automatic_Loc_for_Customer.html)
. If you have other fields in the file that you wish to import into another table, such as location information, you can
run a query in the “After Insert Query” text box.

The Insert button can be used to insert field place holders from the related import file record.
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The above query states that the named fields from the Import Specifications should be inserted in the Locations
table as named above.

You’re now ready to run the import.

To Run the Import:

1. Click File

2. Click Administration

3. Click Import

4. From the “Select Import Type” drop down list, select the type of import you are doing, such as Customers.

5. Make sure the “Input File Format” order of the fields are the same order as in the import file.

6. Click the Browse button to select the file to import.
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7. If the import file has column headings, make sure the “Ignore first row of Import File” is checked. This excludes
the first row in the import file, which contains the column headings.

8. If you are updating this record, check the “Allow Updates” checkbox

9. Zero defaults as the number of errors that you’ll see before it aborts the import. Keep this number at zero so
you can see all errors, if any.

10. Click Import

11. Click Yes on the Run Import prompt.

12. In the bottom left corner of the Import box, you will see how many records are being imported into MRM. If
there are any errors, MRM will list them for you.

Please contact our support team(http://www.jobcost.com/Import_Data.html)
 if you have any questions.

13.5. Database Utilities

Database Views allows a Developer access to the database tables and view listings. We strongly suggest
advanced configuration should only be done by trained developers in SQL. Therefore, in order to open the
Database Utilities, you must enter a password. Any wrong changes in the tables and views could result in
disabling of portions of the application. We are not held responsible in the event this occurs.

13.6. Application Configuration
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Application Configuration allows the user access to edit lists, folders, group rights, labels, along with other
advanced settings.

13.6.1. List Maintenance

List Maintenance gives users the ability to manipulate the drop down lists. This is only accessible thru
Administration Settings.

These lists include, but aren’t limited to:

– Department

– Employee Types

– Industry

– Location Type

– Service Call Type

– Tech Type

– Tech Status

To edit a drop down list, such as Service Call Type, do the following:

1. Click File

2. Click Administration

3. Click Application Configuration

4. From the drop down list beside List Maintenance, choose the list that you want to edit, such as Service Call
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Type

5. Options for Service Call types are:

– Bid

– Emergency

– Warranty

– Time and Materials

– Non-Billable

6. You can edit this list by clicking “Add”, “Edit”, or “Delete”.

TIP: If changes do not immediately go into effect, log out of Mobile Resource Manager and log back in.

13.6.2. Application Options

Application Options gives the user access to manipulate items and forms, such as Data Grids and Invoicing.
This is only accessible thru Administration Settings.

To show an example of how to edit the lists, we will change the Site Visit Time Scheduled default time from 8:00
am to 7:00 am.

1. First choose an Option Group, such as Service Call
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2. Notice that the Time Scheduled for the Site Visits default to 8:00 am

3. Click in the right side of the form where it says 8:00 am

4. Change the time to the new default time, such as 7:00 am

5. Click Apply (the button will be enabled after you make a change)

6. Click Close

Now when you create a Site Visit, you will see that the Time Scheduled defaults to the new time scheduled.

13.6.2.1. Cabinets/Folders

This is only accessible thru Administration Settings.
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Cabinets/Folders allows you to edit:

– Cabinets

– Folders

– Forms

– Data Grids

– Reports

– Report Templates

– Special Rights

– Tasks

13.6.2.1.1. Default Startup Folder

You can configure Mobile Resource Manager to open a specific folder by default whenever the program is started.
To do this, you must be logged on with Administrator privileges. Go into Application Configuration, edit the
cabinet. Select the folder you want to open on startup and click the +/- button to set that folder to open. Close any
other folders that are already set to open.

13.6.2.1.2. Cabinets

The Cabinet Form allows you to edit which folders are shown in the cabinet. It also lists the User Groups that
have access to each Cabinet. You can create a new cabinet, edit, or delete an existing cabinet from this form.
You can also add or remove which group has access to view these cabinets.

13.6.2.1.3. Folders
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The Folders form shows what folders are accessible and which groups have access to these folders. You can
create a new folder, edit, or delete an existing folder from this form. You can also add or remove which group has
access to view these folders.

13.6.2.1.4. Forms

Forms gives a list of each form in Mobile Resource Manager, such as the Employee and Customer forms. It also
shows which groups have what type of rights to these forms. Type of rights include a groups ability to Open, Edit,
Create New, Delete, and Print specific forms.

To better explain, let’s take a look at the Customer form. You will notice that the Customer form allows every
group, (Admin, administrative, and Default) every right of access. Depending on the amount of security your
company needs, you may want to edit user group rights.

In the event that you wish to edit a specific group’s rights to a form, such as the Customer form, the following
steps walk you through the process:

1. Click File

2. Click Administration

3. Click Application Configuration

4. Select the form you want to change user group rights to, such as the Customer form.
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5. Select which group you want to edit the rights to, such as Default

6. Click Rights

7. Uncheck the boxes you do not want the group to be able to do, such as Edit or Delete
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8. Click OK

Any users that are in this particular group will no longer be able to Edit or Delete anything on the Customer form.

See User Groups & Rights(http://www.jobcost.com/User_Group_Rights_2_2.html)

13.6.2.1.5. Data Grids

The Data Grids list the names of the grids and what forms they relate to. This also shows which user groups have
rights to these grids, in which you can add or remove a group or edit rights a group has to a specific grid. You
can also create a new grid, edit, or delete an existing grid.

13.6.2.1.6. Reports

Our reports are created using a built-in report system. Reports list the names of the grids and what forms they
relate to. This also shows which user groups have rights to these grids, in which you can add or remove a group
or edit rights a group has to a specific grid. You can also create a new grid, edit, or delete an existing grid.
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To Create a Report:

1. Click New on the Report form.

To Edit an existing report:

1. Click on the report

2. Click Edit

3. The first prompt, the Report View Edit form is opened

4. Click Edit next to “New”

5. You must select an existing Report Template from the drop down list to continue

6. Click Edit Report Definition

7. The built-in report writer now shows the report template
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To Delete an existing report that is listed on the Report form:

1. Click on the report and click Delete

See User Groups & Rights(http://www.jobcost.com/User_Group_Rights_2_2.html)

13.6.2.1.7. Special Rights

Special Rights shows which Groups have the Special Rights.

13.6.2.1.8. Tasks

The Tasks form shows all tasks in the cabinets. Tasks include Billing, Dispatch Boards, and Maps.

You can either create New, Edit, or Delete a task. You can also add which User Group has rights to that
particular task.

13.6.2.2. Users

The Users folder holds User Groups and Employees lists. User Group Rights are described as groups that are
created with having rights to open, edit, create new, delete, and print specific forms. Once created, you can add
employees to these groups. The employees will take on the same privileges as the group has. User Groups and
their rights are set up and altered by your Administrator or MRM Support.(http://www.jobcost.com/Users.html)
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13.6.2.2.1. Setting Up Group Rights

Mobile Resource Manager is set up with 2 User Groups: Admin and Default.
The Admin Group is set up to allow every privilege for any user that is in that group.
The Default Group is set up with few advanced privileges. Users in the Default group do not have access to
Administrative settings.
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Remember that cabinets are used as an organizational tool, containing its own set of folders. A specific folder,
such as the “Dispatch” folder, can be in multiple cabinets. The majority of Mobile Resource Manager clients have
only one office so they only have one cabinet. Some clients have multiple offices so they set up cabinets for each
office location.

We mention this because there is a direct relationship between User Groups and the Cabinet and folders that are
viewable in the cabinet. User Group Rights may restrict privileges at the Folder and Cabinet View levels. If a user
has rights to a particular cabinet, that cabinet will be included in the combo box above the folder list. Rights to a
specific cabinet does not affect other rights, such as what folder you have access to. For example, if a user has
rights to a cabinet that includes a folder that they do not have rights to, they will not see that folder. If a user has
rights to a folder but does not have rights to any cabinet that contains that folder, they will not have access to the
folder.

To access the groups:

1. Click File

2. Click Administrator

3. Click Application Configuration

4. Click the + by Users

5. Click User Groups

6. “Group Name” lists all the groups. “Employee” lists which employees are in that group.

Functions Available Here:
New – Creates a new User Group

Edit – Edits the group you select
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Delete – Deletes the selected group

Copy – Copies the selected group and creates a new user
group

 

To Create a New Group:

1. Click New beside the Group list

2. The New Group form appears

3. Name the group, such as “Managers”

4. Click Add beside the “Group has rights to these Cabinets” field to add a Cabinet to the list.

5. Check the check box beside the Cabinet that you want this group to have access to.
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6. Click OK. Then click Remove to remove a specific cabinet from this group. Users in this group will only see
Cabinets that you add.

7. Click Add beside the “Group has rights to these Folders” field to add Folders to the list.

8. Check the check box beside the Folder that you want this group to have access to. Click Remove to remove a
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specific folder from this group. Users in this group will only see Folders that you add.

9. Click on the “View Rights” tab.

10. Click Add beside the “Group has rights to these Views” field to add specific grids and reports to be shown in
their respective folders.
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11. Check the check box beside each view that you want shown in the folders. Clicking Remove will remove that
view from the list and it will not show in any folder in the cabinet. Clicking Rights is described below.

12. Click on the “Form/Special Rights” tab
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13. Click Add beside the “Group has rights to these Special Rights” field to add special rights for this group. You
can add rights to be able to edit the Customer ID field. Click on a Special Right and then click Remove to remove
a special right.

14. Check the check box beside each Special Right you want this group to have.

15. Click Add beside the “Group has rights to these Form Rights” field to add specific form rights for this group.
You can add form rights to a specific form, such as Customers. You can choose for this group to be able to Open,
Edit, Create New, Delete, and Print specific forms. Click a Form Right and then click Remove to remove a form
right.
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16. Click OK when finished.

To Edit a Group:

1. Click on the group you want to edit, such as Admin

2. Click Edit

3. The form appears to allow edits
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4. When you are finished editing, click OK

To edit views in a Group:

1. Click on the group you want to edit, such as Admin

2. Click Edit

3. Click on the View Rights tab

4. The form appears to allows edits
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5. Click <b>Add</b> by Views in order to gain access to different grids and reports to that folder

6. Check the checkbox by each grid or report you want this group to have access to
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7. Click OK

8. Click Close

Contact our support team(http://www.jobcost.com/Setup_Group_Rights.html)
if you have any questions.

13.6.2.2.2. Employees

The Employees list shows all employees, which Group they are in, if they have login access, and if they are
active.

14. FAQs

var faq_accordion = true;var faq_scroll = true;var reveal_effect = 'none';

Advanced Questions

a

When setting up a new Customer there is a place for the salesman. When I click on the list, there is
nothing there. How do I choose the salesmen?

(http://1e1.005.myftpupload.com/ufaqs/when-setting-up-a-new-customer-there-is-a-place-for-the-salesman-when-i-
click-on-the-list-there-is-nothing-there-how-do-i-choose-the-salesmen/)

Posted by jobcosthelp on August 19, 2016 

You must set up an employee as a salesman before they will show up in the salesmen lists on the Customer and
Location forms. See salesmen.(http://www.jobcost.com/Creating_a_Salesman.html)

Category: Advanced Questions(/wp-admin/admin-ajax.php?include_category=advanced-questions)

a
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When I try to open the maps, I get an error message the detail says that there is already a MapPanel.

(http://1e1.005.myftpupload.com/ufaqs/when-i-try-to-open-the-maps-i-get-an-error-message-the-detail-says-that-
there-is-already-a-mappanel/)

Posted by jobcosthelp on August 19, 2016 

You need to install a file called pwstrv2.lic in order for the maps for work.

Category: Advanced Questions(/wp-admin/admin-ajax.php?include_category=advanced-questions)

a

Mobile Resource Manager hosts our software but I can't print from Mobile Resource Manager.

(http://1e1.005.myftpupload.com/ufaqs/mobile-resource-manager-hosts-our-software-but-i-cant-print-from-mobile-
resource-manager/)

Posted by jobcosthelp on August 19, 2016 

If you can print to your printer from another application but not from Mobile Resource Manager, you may need to
download the latest driver for your printer.

Please do the following:
1. Log completely out of MRM

2. Go to the your printer company’s website and download
the latest printer drivers on your machine

3. Save and/or run the driver installation files

4. Call MRM support so that they can install the latest
driver on the server that houses your software

5. Test to see if you can now print from MRM

Category: Advanced Questions(/wp-admin/admin-ajax.php?include_category=advanced-questions)
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a

Where does the list for "Installed by" come from? I can't find it in "List Types".

(http://1e1.005.myftpupload.com/ufaqs/where-does-the-list-for-installed-by-come-from-i-cant-find-it-in-list-types/)

Posted by jobcosthelp on August 19, 2016 

This list can be used two different ways:

1. You can document the actual company that installed the equipment, such as Carrier, OR

2. You can document which of your technicians installed the equipment. If you want to keep track of the actual
company, you need to add List Items to the Installed By List Type. The companies will be accessible from the
drop down list shown below.

Note: If you want it to pull by the Technician that did the installation, you need to change the List Type that this
field is pulling from.

Please do the following:
1. Click on the down arrow beside “Tools” on the

Equipment form

2. Click Customize

3. Click on the Control Properties tab

4. In the left hand drop down box, click the second in the
list “cboInstalledBy: TcbComboBox”

5. Look in the list below it. Find on the left side where it
says “cbListType”.

6. On the list’s right side, select “Technicians” from the
drop down menu

7. Click Save

Category: Advanced Questions(/wp-admin/admin-ajax.php?include_category=advanced-questions)
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Customizing Forms

a

Ho do I customize forms, such as renaming labels or making certain fields mandatory?

(http://1e1.005.myftpupload.com/ufaqs/ho-do-i-customize-forms-such-as-renaming-labels-or-making-certain-fields-
mandatory/)

Posted by jobcosthelp on August 19, 2016 

You can do this through the Tools menu on the specific form:
1. Open the form you want to modify

2. Click on the Tools drop down arrow

3. Select Customize
4. Click on Control Properties
5. Select the field you want to change. If it’s a label field,

change what is in the “Caption” field. If you want to
make a field mandatory or not mandatory, make
changes to the “Required” field.

6. Save your changes

 

Please contact our support team(http://www.jobcost.com/Customizing_Forms.html)
if you have any questions.

Category: Customizing Forms(/wp-admin/admin-ajax.php?include_category=customizing-forms)

Dispatch Board

a

I cannot drag and drop Service Calls onto the Dispatch Board.

(http://1e1.005.myftpupload.com/ufaqs/i-cannot-drag-and-drop-service-calls-onto-the-dispatch-board/)
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Posted by jobcosthelp on August 19, 2016 

The User Group you are a part of may not have edit rights on the Board. You can either change with group you
are in or edit the rights for that group.

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)

a

In the Dispatch Board list, I tried removing the date from Option 1. When I did this, it would not let me
drag a call to the technician without asking to change the Site Visit date.

(http://1e1.005.myftpupload.com/ufaqs/in-the-dispatch-board-list-i-tried-removing-the-date-from-option-1-when-i-
did-this-it-would-not-let-me-drag-a-call-to-the-technician-without-asking-to-change-the-site-visit-date/)

Posted by jobcosthelp on August 19, 2016 

The program requires the date to be in the first column.

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)

a

I keep track of multiple technicians/resources, so I need multiple Dispatch Boards. How do I create one?

(http://1e1.005.myftpupload.com/ufaqs/i-keep-track-of-multiple-techniciansresources-so-i-need-multiple-dispatch-
boards-how-do-i-create-one/)
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Posted by jobcosthelp on August 19, 2016 

The easiest way to create a new Dispatch Board is to save a copy of the existing Dispatch Board.

1. Right-click on the Dispatch Board.

2. Click the “Save As” button located in the bottom left on
the Edit View form.

3. Rename the board to whatever resource you are
tracking, such as Laborers.

 

TIP: When you create a new Dispatch Board to filter out specific resources, such as Laborers, you must filter the
board to only pull that Tech Type. Customize the Board Options through the Board Options button located above
the Dispatch Board.

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)

a

On the Daily Dispatch Board, I would like to change the Hours column to reflect the Standard Hours
instead of Estimated Hours.

(http://1e1.005.myftpupload.com/ufaqs/on-the-daily-dispatch-board-i-would-like-to-change-the-hours-column-to-
reflect-the-standard-hours-instead-of-estimated-hours/)

Posted by jobcosthelp on August 19, 2016 

Unfortunately, this would require custom coding, but there is a workaround. One thing that may help is to look at
the Summary Board. This board is similar to the Multi-Day Board but only shows totals for each day/tech. By
using the format string for “Summary Data” on the dispatch board options form, you can set to show total
estimated/actual/standard/overtime/double-time/total charged (standard + overtime + double-time) for each
day/tech. While he is on the daily board, they can use the buttons above the board to switch back and forth
between daily and summary boards views. If you wish to have it custom coded, please contact Mobile Resource
Manager Support.

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)
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a

Is it possible to print the DB in a date range instead of just what is shown on the monitor?

(http://1e1.005.myftpupload.com/ufaqs/is-it-possible-to-print-the-db-in-a-date-range-instead-of-just-what-is-shown-
on-the-monitor/)

Posted by jobcosthelp on August 19, 2016 

Assuming this if for a multi-day board, follow the instructions below:

1. Open board options dialog

2. Uncheck option to “auto-fit columns” for multi-day
board. They may want to change the “Data Width”
option for multi-day board to a width that makes sense
for a printout

3. Set the board date to the first day they want to print

4. Set the “number days” option for multi-day board for the
number of days they want to print

5. Use the print button. On print dialog, select proper
printer and change settings for paper size and
orientation as necessary

 

TIP: To make it easier on you, you could create a special dispatch board item that could prompt the user for the
date and number days so they don’t have to keep changing settings back and forth.

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)

a

Can I schedule a Site Visit for an entire day, but make it fill up the entire white space for that day on the
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Dispatch Board?

(http://1e1.005.myftpupload.com/ufaqs/can-i-schedule-a-site-visit-for-an-entire-day-but-make-it-fill-up-the-entire-
white-space-for-that-day-on-the-dispatch-board/)

Posted by jobcosthelp on August 19, 2016 

When scheduling Site Visits, the white space for that day automatically lengthens downward to how many Site
Visits are scheduled. If you want to block out for a day, see changing tech
status.(http://www.jobcost.com/Change_Technician_Status.html)

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)

a

On the Daily Dispatch Board, is there a way to stack the Service Calls and Site Visits on top of one
another instead of stacking them left to right?

(http://1e1.005.myftpupload.com/ufaqs/on-the-daily-dispatch-board-is-there-a-way-to-stack-the-service-calls-and-
site-visits-on-top-of-one-another-instead-of-stacking-them-left-to-right/)

Posted by jobcosthelp on August 19, 2016 

Unfortunately no, but you can use the Multi-Day Dispatch Board and set it to show just one day at a time. To do
this:

1. Click on Board Options button located above the
Dispatch Board.

2. On the right hand side, in the Number of Days field, type
in ‘1’

3. Click Save Options.

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)
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a

My Cancelled and Rescheduled Site Visits aren't displaying on the Dispatch Board.

(http://1e1.005.myftpupload.com/ufaqs/my-cancelled-and-rescheduled-site-visits-arent-displaying-on-the-dispatch-
board/)

Posted by jobcosthelp on August 19, 2016 

When the status of a site visit is Canceled or Rescheduled, they are automatically filtered off of the dispatch
boards. Mobile Resource Manager can be adjusted to make display of these site visits optional. Contact support
for details.(http://www.jobcost.com/Dispatch_Board_2_2.html)

Category: Dispatch Board(/wp-admin/admin-ajax.php?include_category=dispatch-board)

Emloyees as Sales/Techs

a

Why isn't my Technician showing up on the Dispatch Board after I chose "Tech" as their Employee Type?

(http://1e1.005.myftpupload.com/ufaqs/why-isnt-my-technician-showing-up-on-the-dispatch-board-after-i-chose-
tech-as-their-employee-type/)

Posted by jobcosthelp on August 19, 2016 
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You can show their Employee Type on the Employee’s form by choosing a type such as ‘Tech’. But this does
not automatically make the employee a technician. See adding a
technician.(http://www.jobcost.com/New_Technician.html)

Category: Emloyees as Sales/Techs(/wp-admin/admin-ajax.php?include_category=emloyees-as-salestechs)

a

I need to show that a technician is on vacation. How can I change a technician's status?

(http://1e1.005.myftpupload.com/ufaqs/i-need-to-show-that-a-technician-is-on-vacation-how-can-i-change-a-
technicians-status/)

Posted by jobcosthelp on August 19, 2016 

You can document a technician’s status, such as when they are on vacation, to show a holiday, or Paid
Time Off. See changing tech status.(http://www.jobcost.com/Change_Technician_Status.html)

Category: Emloyees as Sales/Techs(/wp-admin/admin-ajax.php?include_category=emloyees-as-salestechs)

a

How do you set up the technician rates?

(http://1e1.005.myftpupload.com/ufaqs/how-do-you-set-up-the-technician-rates/)

Posted by jobcosthelp on August 19, 2016 
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Once you add a Technician, you can add their Labor Costs. To do this, simply open up the Technician’s form and
click on the Labor Costs tab.

Category: Emloyees as Sales/Techs(/wp-admin/admin-ajax.php?include_category=emloyees-as-salestechs)

Equipment

a

When you enter new equipment in the system, do you have to assign it to a location? Can you enter it in
and pull the information when you need it?

(http://1e1.005.myftpupload.com/ufaqs/when-you-enter-new-equipment-in-the-system-do-you-have-to-assign-it-to-
a-location-can-you-enter-it-in-and-pull-the-information-when-you-need-it/)

Posted by jobcosthelp on August 19, 2016 

You must enter the location that the piece of equipment is at. When you add a new piece of equipment, you enter
the Type and Manufacturer. After you enter those two, the Model No combo box will be filled in with all model
no’s of that type and manufacturer. If the Model No is not in the list, you can enter it in and will show up
underlined. Also, it will be added to the Master Equipment Type list so that the Model No will show up next time.

Category: Equipment(/wp-admin/admin-ajax.php?include_category=equipment)

a

When we add equipment to the invoice to requisition to the job, can we add it on the Service Call, on the
Equipment tab on the More tab?
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(http://1e1.005.myftpupload.com/ufaqs/when-we-add-equipment-to-the-invoice-to-requisition-to-the-job-can-we-
add-it-on-the-service-call-on-the-equipment-tab-on-the-more-tab/)

Posted by jobcosthelp on August 19, 2016 

There would need to be some flag on the item to indicate it was equipment to be added as opposed to just normal
parts. Also, more information would need to be filled out (equip type, model no, serial no, etc…) then it would be
available from the inventory list.

Category: Equipment(/wp-admin/admin-ajax.php?include_category=equipment)

Error Messages

a

I'm getting an error message "General SQL error. String or binary data would be truncated. The statement
has been terminated."

(http://1e1.005.myftpupload.com/ufaqs/im-getting-an-error-message-general-sql-error-string-or-binary-data-would-
be-truncated-the-statement-has-been-terminated/)

Posted by jobcosthelp on August 19, 2016 

The error message indicates a text field was entered with a length longer than the database allows.

Category: Error Messages(/wp-admin/admin-ajax.php?include_category=error-messages)

 179 / 204



 

 
Mobile Resource Manager

Errors

a

I'm receiving an error message when exporting invoices from MRM into Visual Contract that says "cannot
connect to the database DDVC".

(http://1e1.005.myftpupload.com/ufaqs/im-receiving-an-error-message-when-exporting-invoices-from-mrm-into-
visual-contract-that-says-cannot-connect-to-the-database-ddvc/)

Posted by jobcosthelp on August 19, 2016 

This can occur if there has been a change in the naming of the VC DSN name in the ODBC settings. If an
upgrade has been performed, the name could have been changed in the ODBC, but not in the export.ini file.
Make sure the name in the ODBC settings by Visual Contracct’s VC DSN name is the exact same name used in
the export.ini file.

Category: Errors(/wp-admin/admin-ajax.php?include_category=errors)

a

I'm receiving an error message when exporting invoices from MRM into QuickBooks that says "Cannot
merge list elements".

(http://1e1.005.myftpupload.com/ufaqs/im-receiving-an-error-message-when-exporting-invoices-from-mrm-into-
quickbooks-that-says-cannot-merge-list-elements/)

Posted by jobcosthelp on August 19, 2016 

**ERROR**: Updating QB Customer (ABC Company) (“There was an error when modifying a Customers list,
element “7600000-1116250114?. QuickBooks error message: Cannot merge list elements.” /)
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This can occur if there has been a change in the customer’s name in QB that hasn’t changed in MRM or that
MRM isn’t picking up. MRM Support must go into MRM Database Utilities and remove the QBID number in order
for the customer to transfer back into QB to the right customer. To avoid this in the future, only change customer
and location names in MRM, then export them into QB.

Category: Errors(/wp-admin/admin-ajax.php?include_category=errors)

a

I'm receiving an error message when exporting invoices from MRM into QuickBooks that says "Version of
this record has different deleted count":

(http://1e1.005.myftpupload.com/ufaqs/im-receiving-an-error-message-when-exporting-invoices-from-mrm-into-
quickbooks-that-says-version-of-this-record-has-different-deleted-count/)

Posted by jobcosthelp on August 19, 2016 

**ERROR**: Adding QB Invoice (S1234) (“Object “8A70000-1135082608? specified in the request cannot be
found. QuickBooks error message: Your version of this record has a different deleted count than the one in the
datafile.” /)

This happens if the customer has been deleted from QuickBooks and then re added. QB gives each customer a
QBID number, then in the initial transfer of information from QB to MRM, the customer in MRM has the exact
same information. For example, ABC Company has a QBID number of 123A in QB and MRM, but then you delete
ABC Company and re-add it to QB. Now the new ABC Company has a QBID number of 456B, with a deleted
QBID number of 123A. The customer in MRM still has a QBID number of 123A. When you try to transfer the
invoices over, it looks at the QBID numbers in QB and sees that the 123A has been deleted, so it cannot link the
invoice to the customer. MRM Support must go into MRM Database Utilities and remove the QBID number in
order for the invoices to transfer back into QB to the right customer.

Category: Errors(/wp-admin/admin-ajax.php?include_category=errors)

a
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I'm receiving an error message when exporting invoices from MRM into QuickBooks that says "Could not
get Response Info":

(http://1e1.005.myftpupload.com/ufaqs/im-receiving-an-error-message-when-exporting-invoices-from-mrm-into-
quickbooks-that-says-could-not-get-response-info/)

Posted by jobcosthelp on August 19, 2016 

**ERROR**: Adding QB Invoice (S1234) (Could not get Response Info).

This can occur if there is an ampersand in a field on the invoice, such as the Customer PO number field. Please
contact MRM Support and let them know about the error, but in the meantime, you could replace the ampersand
with a slash. Then, conduct the transfer as normal.

Category: Errors(/wp-admin/admin-ajax.php?include_category=errors)

a

I'm receiving an error message when exporting invoices from MRM into QuickBooks that says "invalid
username or password":

(http://1e1.005.myftpupload.com/ufaqs/im-receiving-an-error-message-when-exporting-invoices-from-mrm-into-
quickbooks-that-says-invalid-username-or-password/)

Posted by jobcosthelp on August 19, 2016 

**ERROR** starting QB Session: Invalid user name or password **Export Aborted: Error connecting to
QuickBooks.

The MRM-QB link is setup to use a specified user name/password. This is stored in the QB file so it should not
matter which workstation is running the link. Although the error would not seem to indicate it, her workstation may
have a different path to the QB file and that could be the source of the error. The ini file stores the path to the QB
file.

Category: Errors(/wp-admin/admin-ajax.php?include_category=errors)
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a

I'm receiving an error message when exporting invoices from MRM into QuickBooks that says "specified
record does not exist in the list":

(http://1e1.005.myftpupload.com/ufaqs/when-opening-invoices-an-error-message-appears-stating-theres-an-
invalid-field-name-why-does-this-happen/)

Posted by jobcosthelp on August 19, 2016 

**ERROR**: Adding QB Invoice (S1128) (“There is an invalid reference to QuickBooks Item “FORKLIFT” in the
Invoice line. QuickBooks error message: Invalid argument. The specified record does not exist in the list.” /)
**ERROR**: Adding QB Invoice (S1843) (No Line Items.)
**ERROR** with XML request: QuickBooks found an error when parsing the provided XML text stream

This error is due to the MRM partno “FORKLIFT” not having a match in the QB item list. They need to add an
item named FORKIFT to the QB item (inventory) list. This error is due to the MRM invoice S1843 not having any
line items. QB requires invoices being imported to have at least one line item. If you have any questions, please
contact Mobile Resource Manager Support.(http://www.jobcost.com/Errors.html)

Category: Errors(/wp-admin/admin-ajax.php?include_category=errors)

Grids/Reports

a

Can I sort data by individual columns in a grid?

 183 / 204



 

 
Mobile Resource Manager

(http://1e1.005.myftpupload.com/ufaqs/can-i-sort-data-by-individual-columns-in-a-grid/)

Posted by jobcosthelp on August 19, 2016 

Yes.

Follow the steps below: 

1.  Click on a grid name from the left pane in order to open
it

2.  Click on the column heading once to sort by ascending
order OR

3.  Click on the column heading twice to sort by
descending order

 

To save the new sort order:

1.  Right click anywhere in the grid to show the sub menu

2.  Hover the cursor over “Grid Layout” to show its sub
topics

3.  Click Save Grid Layout Changes

4.  Check the box beside “Save Current Sort Order”

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)

a

Can I change the widths of columns in a grid?

(http://1e1.005.myftpupload.com/ufaqs/can-i-change-the-widths-of-columns-in-a-grid/)

Posted by jobcosthelp on August 19, 2016 
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Yes.

To resize the column widths:

1.  Click on a grid name from the left pane in order to open
it

2.  Hover the cursor over the end of a column heading to
make the cursor change to two parallel lines with left
and right arrows

3.  Click and hold down the left mouse button

4.  Drag it to the left or right to change the width of the
column

 

To save the new widths:

1.  Right click anywhere in the grid to show the sub menu

2.  Hover the cursor over “Grid Layout” to show its sub
topics

3.  Click Save Grid Layout Changes
4.  Check the box beside “Save Current Column Widths”

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)

a

Can I change the order of columns in a grid?

(http://1e1.005.myftpupload.com/ufaqs/can-i-change-the-order-of-columns-in-a-grid/)

Posted by jobcosthelp on August 19, 2016 

Yes.

To change the column order:

1. Click on a grid name from the left pane in order to open
it

2. Click and hold down the left mouse button on the
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column heading you want to move

3. Drag the column to the new place in the grid

4. Release the mouse button when you’ve placed the
column where you want it at in the grid

 

To save the new order:

1. Right click anywhere in the grid to show the sub menu

2. Hover the cursor over “Grid Layout” to show its sub
topics

3. Click “Save Grid Layout Changes”

4. Check the box beside “Save Current Sort Order”

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)

a

Can I open forms from grids?

(http://1e1.005.myftpupload.com/ufaqs/can-i-open-forms-from-grids/)

Posted by jobcosthelp on August 19, 2016 

Yes, but the form that will appear depends on what grid is open. The “Customers All” grid will open the individual
Customer forms. Follow the steps below, we will use the “Customers All” grid for this example.

1. Click on the Customers [All] grid to open it

2. Double click on a customer’s name

3. The Customer form will open for you to view, which will
also give you access to their location and detailed
information

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)
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a

I would like to include/exclude more fields in an existing grid. How can I change the existing grid in order
to show the fields I want?

(http://1e1.005.myftpupload.com/ufaqs/i-would-like-to-includeexclude-more-fields-in-an-existing-grid-how-can-i-
change-the-existing-grid-in-order-to-show-the-fields-i-want/)

Posted by jobcosthelp on August 19, 2016 

If you want to include any fields from an existing grid, please contact Mobile Resource Manager Support with a
detailed description of your request. They will quickly make any changes to existing grids. However, if you want to
exclude fields in a grid, you can do this on your own by following the steps below:

1. Click on a grid name that you want to change fom the
left pane in order to open it

2. Right click anywhere in the grid to show the sub menu

3. Click Show/Hide Columns
4. Uncheck the boxes beside the field names that you do

not want to see in the grid

5. Click OK. These changes are saved and take effect
immediately

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)

a

I need to be able to view and print the Technician Timesheet for our work week of Saturday through
Friday by individual Technicians as well as a batch job. How do I do this?

(http://1e1.005.myftpupload.com/ufaqs/i-need-to-be-able-to-view-and-print-the-technician-timesheet-for-our-work-
week-of-saturday-through-friday-by-individual-technicians-as-well-as-a-batch-job-how-do-i-do-thisi-need-to-be-
able-to-view-a/)

Posted by jobcosthelp on August 19, 2016 
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The Technician Timesheet report allows you to select a date range to print. The report does not currently allow for
selection of a specific technician but this could be added. Please contact Mobile Resource Manager Support if
you want any changes to this report.

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)

a

I'm receiving an error - "ERROR: Could not find Report Template". What does that mean?

(http://1e1.005.myftpupload.com/ufaqs/im-receiving-an-error-error-could-not-find-report-template-what-does-that-
mean/)

Posted by jobcosthelp on August 19, 2016 

It means that the report template is not installed. If you have the template saved, see report
templates.(http://www.jobcost.com/Report_Templates_2.html)
 If you do not have the template, please contact Mobile Resource Manager Support and they will be happy to
install the report template for you.

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)

a

How do I change the column width?

(http://1e1.005.myftpupload.com/ufaqs/how-do-i-change-the-column-width/)

Posted by jobcosthelp on August 19, 2016 
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You can resize the column widths.

Do the following:

1. Hover the cursor over the end of a column heading to
make the cursor change to two parallel lines with left
and right arrows

2. Click and hold the mouse button and drag it to the left or
right to change the width of the column

3. Right click on the grid itself to show the menu

4. Select Grid Layout – Save Grid Layout Changes
5. Check the box beside “Save Current Column Widths”

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)

a

I want to change the order of the existing columns in a grid. How do I do that?

(http://1e1.005.myftpupload.com/ufaqs/i-want-to-change-the-order-of-the-existing-columns-in-a-grid-how-do-i-do-
that/)

Posted by jobcosthelp on August 19, 2016 

You change the column order in grids by clicking and dragging their column heading to their new place in the grid.

To save the new order:

1.  Right click on the grid itself to show the menu

2.  Select Grid Layout – Save Grid Layout Changes

3.  Check the box beside Save Current Sort Order

Category: Grids/Reports(/wp-admin/admin-ajax.php?include_category=gridsreports)
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Import/Export

a

When I run the Zip Code Import procedures, I receive this error: "Application Error: qryUtility: Field
'afterupdatequery' not found". What do I do?

(http://1e1.005.myftpupload.com/ufaqs/when-i-run-the-zip-code-import-procedures-i-receive-this-error-application-
error-qryutility-field-afterupdatequery-not-found-what-do-i-do/)

Posted by jobcosthelp on August 19, 2016 

You might receive this if there is an error in one of the tables. Please contact
support(http://www.jobcost.com/Import_Export.html)
to resolve this issue.

 

 

Category: Import/Export(/wp-admin/admin-ajax.php?include_category=importexport)

a

I clicked on the Zip Code grid and there's nothing there.

(http://1e1.005.myftpupload.com/ufaqs/i-clicked-on-the-zip-code-grid-and-theres-nothing-there/)

Posted by jobcosthelp on August 19, 2016 
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If nothing pulls up in the grid, Mobile Resource Manager Support can conduct an import of the zip codes for you.
Please contact Mobile Resource Manager Support(http://www.jobcost.com/Import_Export.html)
for further assistance

Category: Import/Export(/wp-admin/admin-ajax.php?include_category=importexport)

Invoices/Accounting

a

The invoices generated from MRM do not have our address listed. How can I change that?

(http://1e1.005.myftpupload.com/ufaqs/the-invoices-generated-from-mrm-do-not-have-our-address-listed-how-can-
i-change-that/)

Posted by jobcosthelp on August 19, 2016 

In order to change the address on the invoice to show your company’s address, please do the following:

1. Click File
2. Click Administration
3. Click Application Options
4. Select “Report Headers”

5. On the right side of the form, enter the correct
information

6. Click OK

Category: Invoices/Accounting(/wp-admin/admin-ajax.php?include_category=invoicesaccounting)

a
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The invoices generated from MRM have a prefix in front of them. I want to change/remove the prefix.

(http://1e1.005.myftpupload.com/ufaqs/the-invoices-generated-from-mrm-have-a-prefix-in-front-of-them-i-want-to-
changeremove-the-prefix/)

Posted by jobcosthelp on August 19, 2016 

In order to change or remove the prefix, you must go into the Administration settings. See Application
Options.(http://www.jobcost.com/Application_Options.html)

Category: Invoices/Accounting(/wp-admin/admin-ajax.php?include_category=invoicesaccounting)

a

Is there a way to get MRM to export Service Contracts in Dispatch as Jobs in VC?

(http://1e1.005.myftpupload.com/ufaqs/is-there-a-way-to-get-mrm-to-export-service-contracts-in-dispatch-as-jobs-
in-vc/)

Posted by jobcosthelp on August 19, 2016 

Right now we manually add these jobs into VC. The following are options for exporting jobs from MRM to VC that
have currently been coded into the export application: (If Jobs are exported, determine what MRM items
are exported as Jobs in VC. This is Ignored if ExportJobsFromVC is set to “Y”)

Options are:

– All Service Calls

– Locations with non-blank LocID

– Service Calls with blank ProjNo field

– Service Calls with no ProjNo and Service Contracts (‘MC-‘ + svccont.refno)

– Mitchs Export

– Locations will be exported as jobs if there is a service contract (propaccepted = 1)
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– or at least one service call. Export will occur if either the location, any service contract, or any service call that
has been entered/modified since last export.

– The related custid for the location will be used as CustID in VC

– Of the currently available choices, the closest would be “4”.

Category: Invoices/Accounting(/wp-admin/admin-ajax.php?include_category=invoicesaccounting)

a

Some invoices exported from MRM have ended up duplicated in QB. These duplicate invoices were
exactly the same, including the invoice number. How does this happen?

(http://1e1.005.myftpupload.com/ufaqs/some-invoices-exported-from-mrm-have-ended-up-duplicated-in-qb-these-
duplicate-invoices-were-exactly-the-same-including-the-invoice-number-how-does-this-happen/)

Posted by jobcosthelp on August 19, 2016 

The way the MRM-QB link normally works, when you try to create a new invoice in QB and that invoice no already
exists in QB, the import fails and an error message is generated. The only reason there would be any duplicates
is if they manually set the transferred status to not transferred after it was exported to QB (if they needed to edit it)
and did not reset to transferred.

Category: Invoices/Accounting(/wp-admin/admin-ajax.php?include_category=invoicesaccounting)

a

If I have an invoice dated June 30th, but I don't export it into my accounting software until July 1st. What
month will it post for?

(http://1e1.005.myftpupload.com/ufaqs/if-i-have-an-invoice-dated-june-30th-but-i-dont-export-it-into-my-accounting-
software-until-july-1st-what-month-will-it-post-for/)
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Posted by jobcosthelp on August 19, 2016 

Invoices go into the accounting month based on invoice date. So 06/30/xx will go to 06/30/xx & 06/20xx. The
exception is that if 06/20xx is closed, the invoice will go to 07/20xx.

Category: Invoices/Accounting(/wp-admin/admin-ajax.php?include_category=invoicesaccounting)

a

Can I issue multiple invoices for the same call?

(http://1e1.005.myftpupload.com/ufaqs/can-i-issue-multiple-invoices-for-the-same-call/)

Posted by jobcosthelp on August 19, 2016 

Mobile Resource Manager only allows one invoice per service call.

Category: Invoices/Accounting(/wp-admin/admin-ajax.php?include_category=invoicesaccounting)

Maps

a

When I click on any of the Map icons, I get an error message similar to "Access violation at address
03858CB in module pwstrv2.ocx. Read of address 00006643."
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(http://1e1.005.myftpupload.com/ufaqs/when-i-click-on-any-of-the-map-icons-i-get-an-error-message-similar-to-
access-violation-at-address-03858cb-in-module-pwstrv2-ocx-read-of-address-00006643/)

Posted by jobcosthelp on August 19, 2016 

MRM Support needs to add your map data information and set up your Map HQ addresses. Please let them
know(http://www.jobcost.com/Maps_4_2.html)
which states you need maps for.

Category: Maps(/wp-admin/admin-ajax.php?include_category=maps)

Miscellaneous

a

Is there a way to sort by more than one item?

(http://1e1.005.myftpupload.com/ufaqs/is-there-a-way-to-sort-by-more-than-one-item/)

Posted by jobcosthelp on August 19, 2016 

Yes. See the Filter/Sort button.(http://www.jobcost.com/The_Filter_Sort_Button.html)

Category: Miscellaneous(/wp-admin/admin-ajax.php?include_category=miscellaneous)

a
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Can I locate a Service Call by doing a search by Location or Customer Name?

(http://1e1.005.myftpupload.com/ufaqs/can-i-locate-a-service-call-by-doing-a-search-by-location-or-customer-
name/)

Posted by jobcosthelp on August 19, 2016 

Unfortunately, “Service Calls [Name Search]” is not a default grid. Mobile Resource Manager Support can create
a grid to prompt you to enter the Location or Customer Name and it will pull back all Service Calls associated to
that name. However, there is a work around but it takes a few more steps to do:

1. Click on the Locations [Name Search] grid

2. Type in the name or part of the name of the location you
want to search for

3. Double click on the specific location

4. Click on the Detail tab. There will be a list of Recent
Service Calls or you can click on the Service Call [All]
tab to view all Service Calls that were at the Location

Category: Miscellaneous(/wp-admin/admin-ajax.php?include_category=miscellaneous)

a

How do I enter different Technician hours for a job? For example, Tech A arrives at 8:10 am and Tech B
arrives to help at 8:30 am, Tech B leaves at 9:30 am and Tech A finishes up at 10:15.

(http://1e1.005.myftpupload.com/ufaqs/how-do-i-enter-different-technician-hours-for-a-job-for-example-tech-a-arri
ves-at-810-am-and-tech-b-arrives-to-help-at-830-am-tech-b-leaves-at-930-am-and-tech-a-finishes-up-at-1015/)

Posted by jobcosthelp on August 19, 2016 

Each Service Call can have many Site Visits. Each Site Visit can have many Technicians. If each Tech will have
different arrival and departure times, they should be put on separate Site Visits (one Tech per Visit). If they
will have the same arrival and departure times they can both be linked to the same site visit (many Techs per
Visit).

 196 / 204



 

 
Mobile Resource Manager

Category: Miscellaneous(/wp-admin/admin-ajax.php?include_category=miscellaneous)

a

I need to edit a drop down list but I do not see it in Application Options List Maintenance.

(http://1e1.005.myftpupload.com/ufaqs/i-need-to-edit-a-drop-down-list-but-i-do-not-see-it-in-application-options-list-
maintenance/)

Posted by jobcosthelp on August 19, 2016 

If there is a list that needs to be manipulated, please contact Mobile Resource Manager Support and they will be
able to edit the list and explain how to get to it.

Category: Miscellaneous(/wp-admin/admin-ajax.php?include_category=miscellaneous)

a

If you hover over the Closed By date in the bottom of the Main info tab you can double click it and change
the closed date. Is this something that I can turn off by user?

(http://1e1.005.myftpupload.com/ufaqs/if-you-hover-over-the-closed-by-date-in-the-bottom-of-the-main-info-tab-
you-can-double-click-it-and-change-the-closed-date-is-this-something-that-i-can-turn-off-by-user/)

Posted by jobcosthelp on August 19, 2016 

Currently, this would only be turned off if the user group did not have edit rights to the Service Call form or if the
Service Call itself was read-only (i.e. after the related invoice was transferred.)
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Category: Miscellaneous(/wp-admin/admin-ajax.php?include_category=miscellaneous)

New and Optional Features

a

Can I link documents into Service Calls in MRM?

(http://1e1.005.myftpupload.com/ufaqs/can-i-link-documents-into-service-calls-in-mrm/)

Posted by jobcosthelp on August 19, 2016 

Yes, but it is a separate feature. This feature also allows you to link documents specifically to a customer and/or
location. Please contact your salesman(http://www.jobcost.com/Sales.html)
to purchase the Document Linking feature.

Category: New and Optional Features(/wp-admin/admin-ajax.php?include_category=new-and-optional-features)

Printing

a

When I try to print from Mobile Resource Manager, I get an error message "No default printer is selected."

(http://1e1.005.myftpupload.com/ufaqs/when-i-try-to-print-from-mobile-resource-manager-i-get-an-error-message-
no-default-printer-is-selected/)
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Posted by jobcosthelp on August 19, 2016 

Please do the following:

1. Log out of Mobile Resource Manager

2. Click on Start – Printer and Faxes (or go into the Control
Panel and find Printer and Faxes)

3. Make sure a default printer is selected. There should be
a black checkmark beside a default printer.

4. Right click on the printer and select Properties

5. Click on the Sharing tab to see what print driver you
have installed. Write this down. Close Properties.

6. Open up another application, such as Word, and try to
print to the default printer.

7. Go to the website of the printer and download the latest
printer driver onto your machine

8. Save and run it

9. Try to print from any application

10. Try to print from MRM

Category: Printing(/wp-admin/admin-ajax.php?include_category=printing)

Sending Text

a

I'm getting an error message when sending text: "Error: Login Failure".

(http://1e1.005.myftpupload.com/ufaqs/im-getting-an-error-message-when-sending-text-error-login-failure/)

Posted by jobcosthelp on August 19, 2016 

The error message means that the login to their email account failed. The ID and PW would be the login
information for their email account. If you are using Microsoft Exchange, the ID and PW would be their Windows
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login ID and PW. If you are using an external email account (like Earthlink, etc…) you should enter the login ID/PW
for that account. This information is stored per MRM login, so if one user enters this, it doesn’t mean a different
MRM user would be setup.

Category: Sending Text(/wp-admin/admin-ajax.php?include_category=sending-text)

a

I can't send text.

(http://1e1.005.myftpupload.com/ufaqs/i-cant-send-text/)

Posted by jobcosthelp on August 19, 2016 

You must set up Text Service Providers, enter a Text Number for an employee, and set up Text Settings before
you will be able to send text. See sending text.(http://www.jobcost.com/Text_Settings.html)

Category: Sending Text(/wp-admin/admin-ajax.php?include_category=sending-text)

Service Calls & Site Visits

a

How can I create recurring visits (1st Thursday of the month, etc.) on the dispatch board?

(http://1e1.005.myftpupload.com/ufaqs/how-can-i-create-recurring-visits-1st-thursday-of-the-month-etc-on-the-
dispatch-board/)
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Posted by jobcosthelp on August 19, 2016 

Instead of using the New button on the Site Visits tab to create one new visits, use the Multi button to create
multiple visits for this Service Call.

Category: Service Calls & Site Visits(/wp-admin/admin-ajax.php?include_category=service-calls-site-visits)

a

When creating a new Service Call, I would like to change the Location Lookup list to include the Location
Territory field. How do I do that?

(http://1e1.005.myftpupload.com/ufaqs/when-creating-a-new-service-call-i-would-like-to-change-the-location-
lookup-list-to-include-the-location-territory-field-how-do-i-do-that/)

Posted by jobcosthelp on August 19, 2016 

Unfortunately, this form is not user-definable. Any changes to this form would have to be done by Mobile
Resource Manager Support. Please contact them(http://www.jobcost.com/Service_Calls_Site_Visits.html)
or your salesman(http://www.jobcost.com/Sales.html)
.

Category: Service Calls & Site Visits(/wp-admin/admin-ajax.php?include_category=service-calls-site-visits)

Service Contracts

a
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When I try to link the Service Contract to the Service Call, MRM will not allow it to save.

(http://1e1.005.myftpupload.com/ufaqs/when-i-try-to-link-the-service-contract-to-the-service-call-mrm-will-not-allow-
it-to-save/)

Posted by jobcosthelp on August 19, 2016 

If you have already transferred the Invoice created on that Service Call, MRM will not allow you to link the Service
Contract to that Service Call. If you would like this custom feature, please contact our support
team(http://www.jobcost.com/Service_Contracts_2_2.html)
.

Category: Service Contracts(/wp-admin/admin-ajax.php?include_category=service-contracts)

a

Can we add a 'Do Not Renew' button on the Service Contracts form so that when it is enabled on a
contract and we attempt to renew it, the contract will not renew?

(http://1e1.005.myftpupload.com/ufaqs/can-we-add-a-do-not-renew-button-on-the-service-contracts-form-so-that-
when-it-is-enabled-on-a-contract-and-we-attempt-to-renew-it-the-contract-will-not-renew/)

Posted by jobcosthelp on August 19, 2016 

We can update MRM to include a “Not Renewed” checkbox on the Service Contract form. After that, we can
modify it to not renew contracts where this value is true (checked). Contact MRM support for
this.(http://www.jobcost.com/Service_Contracts_2_2.html)

Category: Service Contracts(/wp-admin/admin-ajax.php?include_category=service-contracts)
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User Group Rights

a

What's the relationship between Cabinets & Folders? Since we have multiple offices, we were thinking of
setting up a Cabinet for each office location.

(http://1e1.005.myftpupload.com/ufaqs/whats-the-relationship-between-cabinets-folders-since-we-have-multiple-
offices-we-were-thinking-of-setting-up-a-cabinet-for-each-office-location/)

Posted by jobcosthelp on August 19, 2016 

A Cabinet is a set of Folders. A specific folder, such as “Dispatch”, can be in multiple cabinets. The Cabinet is
used as an organizational tool. The majority of Mobile Resource Manager clients have only one cabinet and may
restrict rights at the Folder and View levels.

Category: User Group Rights(/wp-admin/admin-ajax.php?include_category=user-group-rights)

a

How do I set up user groups?

(http://1e1.005.myftpupload.com/ufaqs/how-do-i-set-up-user-groups/)

Posted by jobcosthelp on August 19, 2016 

MRM is set up with 2 standard groups, Admin and Default. If you have users that need access to any and all
cabinets and folders, put them in the Admin group. If you have users that you do not want full administrative
privileges, put them in the Default group. To set up different groups or to edit the existing groups, see setting up
user groups.(http://www.jobcost.com/Setup_Group_Rights.html)
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a

How do I set up user rights for an individual?

(http://1e1.005.myftpupload.com/ufaqs/how-do-i-set-up-user-rights-for-an-individual/)

Posted by jobcosthelp on August 19, 2016 

Once you enter a user, under the Group’s drop down list, choose which group you would like to add them to.

Category: User Group Rights(/wp-admin/admin-ajax.php?include_category=user-group-rights)
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